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About This Book

The NetView for AIX User's Guide for Beginners provides a foundation for under-
standing and operating the IBM* NetView* for AIX* (hereafter referred to as NetView for
AIX) program. It explains what this program does and how to use it to manage and
monitor an open systems network.

What Happened to the NetView for AIX User's Guide?
The User's Guide has been divided into two separate books. Why? Because you, our
customers, asked for it!

We heard you say you want one book for beginners and one book for advanced users.
You want a book you can give to a network operator or someone not familiar with
NetView for AIX. That's the NetView for AIX User's Guide for Beginners. It contains
introductory information and lots of step-by-step tasks that help a new user understand
how NetView for AIX manages networks.

The rest of the information is now in the NetView for AIX Administrator's Guide. This
book is for the advanced user, a systems administrator, or perhaps an experienced
network operator, depending on how your group is organized. Most of the tasks pre-
sented in this book require root authority and a read-write map. For example, we've
included information about customizing the graphical interface, filtering events, and
managing your network. We've also included new information on configuring backup
managers and monitoring system performance.

Let us know how you like this new way of presenting information. Use the form at the
back of this book to send us your comments, ideas, and suggestions. Remember, we
are listening!

Who Should Use This Book
The NetView for AIX User's Guide for Beginners is for network operators and others
who are new to the NetView for AIX program. A secondary audience is system admin-
istrators, who should be familiar with the tasks included here so they can use them for
training.

How to Use This Book
This book presents basic concepts by using tasks that can be performed with a
read-only map. This book assumes you are using the NetView for AIX defaults. The
following topics are covered in this book:

¹ Chapter 1, “Getting Acquainted with NetView for AIX” on page 1 describes how to
start the NetView for AIX program, work with a mouse and windows, get help, and
exit the NetView for AIX program.
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¹ Chapter 2, “Understanding Network Management” on page 31 introduces network
management concepts and terms that will be used throughout the rest of the
manual.

¹ Chapter 3, “Working with Maps” on page 39 explains the relationships among the
basic elements of the NetView for AIX program: objects, symbols, maps, and
submaps.

¹ Chapter 4, “Using Events and Workspaces” on page 57 explains how events
provide information about network changes and describes how to use workspaces
to group events for further processing.

¹ Chapter 5, “Monitoring a Network” on page 73 presents basic network monitoring
tasks that network operators are likely to perform.

A Note to the System Administrator

The tasks in this book are for network operators who are unfamiliar with the
NetView for AIX program. These tasks have been designed to ensure that basic
concepts are introduced in a logical sequence. So that important network data is
not accidentally altered or deleted, network operators should work with a read-only
map. However, these tasks can still be accomplished with a read-write map. The
map should contain the following items:

¹ An IP Internet symbol on the Root submap

¹ A non-IP symbol on the Root submap

¹ An executable symbol on the IP Internet submap (executing should produce a
pop-up window with an OK button)

¹ A map snapshot

¹ Read-write access to the /tmp/xnmgraph.data directory to save graphed data

¹ A network submap with symbols representing status of normal, marginal, and
critical. Chapter 5, “Monitoring a Network” on page 73 contains scenarios for
handling problems. Refer to that chapter to see the condition the network
needs to be in for the user to perform the tasks presented in the chapter.

¹ A copyright window, navigation tree, tool window, and control desk that have
not been disabled.

¹ A default color scheme.

¹ Security user environment variables.

Of course, if it's not possible to tailor a map, you can select tasks based on what is
available on the map you use to train new operators.

To open a map with read-only access, use the following command:

nv6000 -ro -map <mapname>
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Chapter 1. Getting Acquainted with NetView for AIX

Welcome to the IBM NetView for AIX (NetView for AIX) program and the world of
network management.

If you haven't worked with windows on a desktop or used the NetView for AIX program
before, this chapter is the place to begin. If you already understand the following
topics, you can skip this chapter and go to Chapter 2, “Understanding Network
Management” on page 31.

¹ “Starting the NetView for AIX Program”
¹ “Managing NetView for AIX Windows” on page 7
¹ “Getting Help” on page 27
¹ “Exiting the NetView for AIX Graphical Interface” on page 30

Before You Begin

This chapter is based on what happens by default when the NetView for AIX
program starts. You might see differences between the information in this chapter
and what appears on your screen, for example, default colors and window posi-
tions. But you can still use the tasks presented here to learn about the NetView for
AIX program.

Starting the NetView for AIX Program
To start the NetView for AIX program, type the /usr/OV/bin/nv6000  command in an
aixterm window and press the Enter key.

Make a Note

Your system administrator might want you to use a different command to start the
NetView for AIX program.

Write the command here: ______________

If the message “Starting user interface applications” appears in your aixterm window,
the NetView for AIX program's graphical interface is starting.

If the NetView for AIX program doesn't start after you type the /usr/OV/bin/nv6000
command, ask your system administrator for help.

Logging into NetView for AIX
If security services are already turned on, you see the NetView for AIX Authentication
Dialog Box. You will need to enter your Login Id, Group Id (if it is not already dis-
played), and Password. Your system administrator will give you this information the
first time you log into NetView for AIX. These fields are case sensitive. You need to
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type the information in exactly as it is given to you. If you log in successfully, you will
see in the message area: Login Authentication was successful. If you do not log in
successfully, you will see in the message area: Login Authentication failed followed by
a more specific message.

You can set environment variables, NVID and NVGID, in each user's .profile or .kshrc
file so that the user's login ID and group ID are automatically displayed in the
Authentication login panel.

For example, if Diane's login ID is diane in the Oper group, add the following lines to
Diane's .profile:

export NVID=diane

export NVGID=Oper

Figure 1. Log In Panel on NetView for AIX Authentication Dialog Box
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There are three tasks you can perform after logging into NetView for AIX:

1. Changing your password

2. Looking at your profile

3. Performing shift in / shift out tasks

To change your password:
1. Select Options from the menu bar.

2. Select Change Password from the Operations pull-down menu

Figure 2. Change Password Panel on NetView for AIX Authentication Dialog Box

3. Type your Login Id, Old Password, and New Password.
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 4. Select Apply.

5. You are prompted to enter your new password again. The message area box dis-
plays status.

Figure 3. Password Verification NetView for AIX Authentication Dialog Box

To view your current profile:
1. Select Operations from the menu bar.

2. Select Show Profile to view your current profile status.

3. Select Close to return to the NetView for AIX Authentication Dialog box.
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Figure 4. User Profile

To perform shift in / shift out operations:
1. Select Operations from the menu bar.

2. Click on the appropriate Shift in / Shift out task.

Note:  Selecting shift out displays a screen saver and security key on your terminal
while NetView for AIX runs in the background. Double clicking on the key displays the
NetView for AIX Authentication Dialog Box already in shift in mode. If you have clicked
on the key and decide you're not ready to log in, click on the Reset button to regain the
screen saver.

Shift in/shift out provides easy transition of ownership during shift or operation changes,
without stopping the user interface. In order to shift in from shift out mode, an operator
must be in the same group using the same AIX user ID. Your system administrator
should have already established group identification. After you fill in the NetView for
AIX Authentication Dialog box (Login Id, Group Id, and Password), you are logged into

  Chapter 1. Getting Acquainted with NetView for AIX 5



NetView for AIX. When you exit the NetView for AIX program, security services auto-
matically disconnects and logs you out.

Watching NetView for AIX Initialize
You will notice lots of activity on the screen as the NetView for AIX program starts.
This section describes what you need to know about what's happening. You might try
reading and following as the NetView for AIX program initializes, although if your work-
station is fast, you'll have to speed-read! Here's the approximate order of occurrence:

1. Windows of different sizes appear, first completely gray, then outlined with borders
and filled with colorful graphics.

The COPYRIGHT INFORMATION window contains copyright information. It
doesn't need to remain open for the entire NetView for AIX session. You'll learn
how to close it soon.

2. Keep watching the bottom-left corner of the leftmost window. There's a status line
that explains what's happening. You should see “Initializing” in the status line, and
over on the right you should see, in succession, the following messages:

 ¹ Registering Symbols

Identifying all of the symbols that will be used by the NetView for AIX program
to represent network devices

 ¹ Registering Applications

Identifying all of the applications that will work with the NetView for AIX
program to monitor and manage the network

 ¹ Initializing Menus

Getting all the NetView for AIX menus ready to be displayed and used

 ¹ Opening Map

Opening a map that represents the network.

3. Next, two buttons, labeled “Tree” and “Tools” are displayed in the lower-left corner.
You'll learn about them later.

4. The window expands to include a bottom half called the control desk. The window
now fills the left side of the screen from top to bottom. The status line has moved
to the very bottom of the window.

5. Notice how the message has changed:

<name of map> [Read-Only] [Synchronizing]

Read-Only indicates that the map you are going to work with does not permit you to
edit or to perform other tasks that might cause changes in the NetView for AIX
program's files or databases. Synchronizing indicates that the map is being
updated with any network changes that occurred since this map was last viewed.

6. The Tools window fills with white rectangles that eventually contain graphics and
text. You'll learn more about this window in “Using the Tools Window” on page 17.

7. The Navigation Tree window contains a symbol labeled RootMap,
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RootMap

. You'll work with this window in “Exploring the Submap Hierarchy” on page 47.

8. Once synchronizing is finished, the right side of the status line displays the fol-
lowing message:

Root [Auto-Layout]

Note:  The amount of time it takes to complete synchronization depends upon the
amount of information in the database.

This part of the status line indicates the name of the submap currently displayed
and specifies how symbols are to be placed on the submap. Submaps are
described in “Learning about Maps and Submaps” on page 45.

9. Event cards are now displayed in the control desk window.

10. The submap area shows an IP Internet symbol,

IP Internet

.

Don't be concerned if you didn't understand everything you just read and saw. This
chapter can help you learn what you need to know about working with the NetView for
AIX program's windows. And now, let's get started!

Managing NetView for AIX Windows
You already know that the AIX Desktop can display numerous windows at the same
time. That means you can work more efficiently, because you can be performing a task
in one window while watching tasks running in other windows. And you've just watched
the NetView for AIX program's windows initialize, so you have an idea what the default
graphical interface looks like. In this section, you'll learn how to use a mouse to
manage the windows on the NetView for AIX graphical interface.

Using a Mouse to Manage Windows
You can use any 2- or 3-button mouse to work with NetView for AIX windows.
Figure 5 on page 8 shows how the buttons are numbered. We'll explain how to use
the buttons, and in what combinations, when you need to know that for a particular
task.
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Button 3 Button 3

Button 2

Button 2

Button 1

Button 1

Figure 5. Use any 2- or 3-button mouse with NetView for AIX windows.

If you have a left-handed mouse, the positions for buttons 1 and 3 are the opposite of
those shown in Figure 5.

Now that you know which mouse button is which, click mouse button 1 on the OK
button in the COPYRIGHT INFORMATION window to close the window.

Identifying NetView for AIX Windows
Here's a short description of how each of the NetView for AIX program's windows is
used. Look for each of these windows in Figure 6 on page 9.

Submap window [1] Displays a view of part of the network.

Control Desk window [2] Displays a grouping of active applications. Initially, this
window contains the Events Application that displays
cards that give you information about network events.

Tools window [3] Provides access to applications or tools that you regu-
larly use.

Navigation Tree window [4] Provides a view of the navigation relationship; the path
the user followed to reach a certain view. The navigation
relationship provides a way to keep track of where you
are and how you got there. The navigation tree layout
will only show one tree at a time. There is an area (View
Root) in the upper portion of the Navigation Tree with
icons representing root nodes of all the trees available.
You can single click on an icon to see the corresponding
tree.
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1

2 3

4

Figure 6. The NetView for AIX graphical interface offers convenient access to network manage-
ment tools.

Click mouse button 1 anywhere within the Navigation Tree window. Notice that the
border of the Navigation Tree window is blue while the borders of the other windows
are gray (if the defaults haven't been changed).

 Key Concept

The window whose border is blue is known as the active window. If you don't see
a blue border, you'll notice that the active window is highlighted in some way so
that it stands out from the other windows. This is the only window you can interact
with, for example, by entering text or clicking on a button to initiate processing. To
make another window active, click mouse button 1 anywhere inside the window
border.

Managing Windows on Your Desktop
You know what it's like when your desk is buried under layers of paper, books, and
empty candy-bar wrappers—finding something becomes an excavation instead of a
simple search. The same thing can happen to your AIX desktop. When you need to
be able to respond quickly to changing network conditions, you can't waste time
cleaning up or searching. Here are some window management techniques to help you
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keep your AIX desktop clutter to a minimum. Use Figure 7 on page 10 to guide you
through the tasks in this section.

1

4

2

2

3

Figure 7. NetView for AIX windows can be moved and sized.
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Moving a Window
Practice moving the Navigation Tree window around the desktop.

Step 1. Press and hold mouse button 1 on the title bar [1] of the window. If you
move the mouse slightly, the mouse pointer changes to a crossbar. That lets
you know you are moving a window.

Step 2. Drag the window to a new location.

Step 3. Release mouse button 1.

Sizing a Window
Practice changing the size of the Navigation Tree window.

Step 1. Press and hold mouse button 1 on the border [2] of the window. Wait until
the mouse pointer changes to a different arrow.

Step 2. Drag the border in the direction you want to size the window.

Step 3. Release mouse button 1 when the window is the size you want.

Can you make the window completely disappear? You shouldn't be able to.
There are minimum sizes for some of the NetView for AIX windows.

Using the Minimize and Maximize Buttons to Control Window Size
The minimize and maximize buttons give you more ways to control the size of windows.
Practice using these buttons in the Navigation Tree window.

 Key Concept

An icon is a graphic symbol, displayed on a screen, that you can point to with a
mouse in order to perform a particular function or select a software application.

Step 1. Move the Navigation Tree window to the center of the desktop.

Step 2. Click on the maximize button [4] in the upper-right corner of the window.

The Navigation Tree window now fills the entire screen. Don't worry; the
other windows are still open behind this one.

Step 3. Click on the minimize button [3].

Where did the Navigation Tree window go? Let's find out.

Step 4. Press and hold mouse button 1 in the title bar of the submap window.
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Step 5. Move the submap window to the right side of the desktop.

The minimized icon for the Navigation Tree window

is in the lower-left corner of the desktop.

Step 6. Click mouse button 1 once on the minimized icon The system menu is dis-
played. Select Restore from the system menu to restore the Navigation Tree
window to its original size and location.

Step 7. Move the submap window back to its original location at the left side of the
desktop.

Using the Tree and Tools Buttons
The NetView for AIX program gives you a quicker way to restore or open the Naviga-
tion Tree window or the Tools window. You can use the Tree and Tools buttons

Tree

Tools

in the submap window.

Use the Tools window to work through this task.

Step 1. Click mouse button 1 anywhere inside the Tools window to make it the active
window.

Step 2. Click mouse button 1 on the system menu button in the Tools window.

Step 3. Select Minimize from the system menu.

You know, because you just saw this happen with the Navigation Tree
window, that the icon for the minimized Tools window is hidden behind one of
the other open windows on the desktop. Instead of moving windows around
to find it, there's an easier way.

Step 4. Click mouse button 1 on the Tools button in the submap window.

The Tools window is once again displayed in its original size and position. Its
border is highlighted, which means it is displayed as the active window.

 Try This

Repeat this same task using the Navigation Tree window.
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Using the System Menu to Manage Windows
The system menu conveniently groups window management functions on one handy
pull-down menu. Let's use the Navigation Tree window in Figure 8 to see how the
system menu helps you manage windows.

Figure 8. The system menu is a convenient window management tool.

Step 1. Click mouse button 1 on the system menu button in the Navigation Tree
window.

The system menu appears. You already know about moving, sizing, mini-
mizing, and maximizing windows. Let's look at the other selections on the
system menu.

Step 2. Move the Navigation Tree window so it is sitting in the center of the submap
window.

Step 3. Select Lower from the system menu.

The Navigation Tree window disappears.

Step 4. Move the other windows on the desktop to see where the Navigation Tree
window is.

You'll find it hiding below the other windows. Lowering doesn't close a
window; it just puts it out of sight. It's like sweeping dirt under a rug—it's still
there, but you can't see it.

Step 5. Click mouse button 1 on the system menu button in the Navigation Tree
window.
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Step 6. Select Close from the system menu.

The Navigation Tree window closes. Do you know how to open it again?
Hint: Remember the buttons in the submap window.

Step 7. Click mouse button 1 on the Tree button in the submap window to open the
Navigation Tree window.

Step 8. Click mouse button 1 on the system menu button in the Navigation Tree
window.

Step 9. Select Maximize from the system menu. Once again, the Navigation Tree
fills the entire screen.

Step 10. Click mouse button 1 on the minimize button or select Size from the Naviga-
tion Tree system menu to resize the window.

Using the Control Desk Window
When the NetView for AIX program starts, the Control Desk Window is attached to the
submap window. You might decide that you want to detach the Control Desk window
from the submap window, so that it becomes a separate window. Later, you might
decide to reattach the Control Desk window to the submap window.

This flexibility in working with the control desk window can help you work more effi-
ciently. For example, if you are monitoring two networks, you can group applications
related to each network in separate control desk windows. You can even attach the
control desks to their respective submap windows. And, because more than one appli-
cation can run in a control desk window, your desktop isn't cluttered with too many
windows. Multiple control desk windows are started by dragging and dropping the
control desk icon. You'll learn about dragging and dropping later in this chapter.

Figure 9 on page 15 shows the control desk window. Refer to this figure while you try
detaching and attaching the control desk window.
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1

Figure 9. The control desk window can be part of the submap window.

Detaching the Control Desk Window from the Submap Window
To detach the control desk window from the submap window, follow these steps:

Step 1. Place the mouse pointer on the control desk handle [1].

Step 2. Press and hold mouse button 2.

Step 3. The mouse pointer changes to a miniature control desk icon.

Step 4. Drag the Control Desk icon outside the submap window.

Step 5. Release mouse button 2 when the control desk icon is in the desired location.
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Attaching the Control Desk Window to the Submap Window
Figure 10 shows a separate control desk window.

Figure 10. A control desk window can be separate from the submap window.

To attach the control desk window to the Submap window, follow these steps:

Step 1. Place the mouse pointer on the control desk handle shown in Figure 9 on
page 15.

Step 2. Press and hold mouse button 2.

Step 3. The mouse pointer changes to a miniature control desk icon.

Step 4. Drag the control desk icon toward the submap window.

Step 5. Release mouse button 2 when the control desk icon is inside the submap
window.

The control desk window is reattached to the submap window.

Dragging and Dropping
Dragging and dropping helps you move icons around the desktop. These icons might
represent submaps or applications. Here's a chance to practice dragging and dropping.

Step 1. Double-click mouse button 1 on the IP Internet symbol in the submap
window.

The IP Internet symbol opens into the IP Internet submap, which contains
symbols that represent networks, routers and the connections between them.

Step 2. Notice that when the IP Internet submap opened, an IP Internet icon
appeared in the Navigation Tree window directly below the RootMap icon.
This new icon has a blue border around it. Once again, if it's not blue it's
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highlighted to stand out from the other icons. The blue border identifies
which of the open submaps is currently displayed.

Step 3. Choose a network symbol, like this one

9.67.160

IP

, on the IP Internet submap. Double-click mouse button 1 on this symbol.

Step 4. A Network submap appears. A corresponding icon appears in the Navigation
Tree window. Now, this icon is the one with the blue border, while the IP
Internet submap icon has a black border, to show that the internet submap is
no longer displayed.

Step 5. Press and hold mouse button 2 on the RootMap icon in the Navigation Tree
window. Wait until the mouse pointer changes to a crossbar.

Step 6. Drag the RootMap icon to an empty space on the desktop and drop it by
releasing mouse button 2.

A new submap window opens, containing the Root submap. This new
submap window is the active window. How can you tell? Hint: It's something
about the window border.

Step 7. Press and hold mouse button 2 on the IP Internet icon in the Navigation Tree
window. Wait until the mouse pointer changes to a crossbar.

Step 8. Drag the icon into the window you just created that currently contains the
Root submap. The window now contains the IP Internet submap.

You've just seen two important principles of window management in action.

 Key Concepts

If you drag and drop a submap icon to an empty space on the desktop, the
submap will be displayed in a new window.

If you drag and drop a submap icon in a window that already exists, the submap
will be displayed in that window. Dragging and dropping within the same window
has the same result as double clicking.

Dragging and dropping is a convenient way to arrange your desktop so you can see
different views of your network side-by-side if you need to do that. It's also helpful for
grouping applications together in one control desk. In fact, that's what you're going to
learn about in “Using the Tools Window.”

Using the Tools Window
The Tools window gives you easy access to applications you'll use frequently to monitor
your network. You could also get to these applications through the NetView for AIX
main menu, but the Tools window is more convenient.
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The NetView for AIX program places certain applications in the Tools window by
default. See Figure 11. Take a look at their names; you'll learn how to use them later
in this manual.

Figure 11. The Tools window contains frequently used applications.

You can drag application icons from the Tools window in the same way that you drag
map icons. Dragging application icons to different places on the desktop means you
can have several independent versions of the same application running at the same
time. You'll see how convenient this feature can be once you begin monitoring a
network.
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You can also use the Tools window to control where an application runs: either in
another control desk window or in its own window.

Dragging and Dropping the Mail Tool Icon
This example uses the Mail tool to help you practice. The same principle applies to all
icons in the Tools window.

Step 1. Make the Tools window the active window.

Step 2. Press and hold mouse button 2 on the Mail icon. Wait until the mouse
pointer changes into a small envelope.

Step 3. Drag the Mail icon to the control desk window and release mouse button 2.

The Mail application is now running in the control desk window.

Step 4. Press and hold mouse button 2 on the Print icon in the Tools window. Wait
until the mouse pointer changes to a small printer.

Step 5. Drag the Print icon to the window where the Mail application is running.

Step 6. Release mouse button 2.

Notice that the Print application is now running in this window. Where is the
Mail application?

Step 7. Click mouse button 1 on the icon for the Mail application that appears in the
application stack on the left side of the window.

Now the Mail application appears in the window.

 Key Concept

More than one application can run in a control desk window at the same time,
although only one of them will be displayed at any given time. You can change
the one that is displayed by clicking mouse button 1 on the appropriate icon in the
Control Desk application stack.

Step 8. Click mouse button 1 on the Mail tool icon to display the Mail tool again.

Step 9. Select Exit from the File pull-down menu in the Mail tool. Careful: Don't
select Exit from the File pull-down menu in a submap window, or you'll close
the NetView for AIX program!

The Mail application closes.

Step 10. Click mouse button 1 on the Print tool icon to display the Print tool again. (If
the Print tool is the only other active application in this control desk window, it
will automatically be displayed.)

Step 11. Select Exit from the File pull-down menu in the Print tool.

The Print tool closes.

Step 12. Now, let's open the Mail application in a separate window. Press and hold
mouse button 2 on the Mail icon in the Tools window. Wait until the mouse
pointer changes to a small envelope.
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Step 13. Drag the Mail icon to an empty space on the desktop and release mouse
button 2.

The Mail application opens in a separate window.

Step 14. Select Exit from the File pull-down menu in the Mail tool to close the Mail tool
and the separate window.

 Try This

Open a new control desk window by dragging and dropping the control desk icon
from the Tools window to another area of the desktop. Then, drag and drop an
application from the Tools window to the control desk window. Finally, close both
the application and the new control desk window.

Scrolling To View Information
Sometimes a window contains more information than you can see at one time. Scroll
bars enable you to see additional information by moving through the information either
vertically or horizontally.

Vertical scroll bars are located on the right side of a window. Use vertical scroll bars to
move up or down in the viewing area of a window.

Horizontal scroll bars are located below a window and enable you to move to the left
and right in the viewing area of a window.

Practice using the scroll bars in the Events display application to understand how they
work. Use Figure 12 and Figure 13 on page 21 to work through this task.

Figure 12. Notice the scroll bars on the right side of the event card.
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Step 1. Press and hold mouse button 3 on the event cards in the control desk
window to display the Work Menu.

Step 2. Move the mouse pointer down to select Switch List<->Cards and release from
the Work Menu. The display changes from a group of cards to a list.

Figure 13. The event list has horizontal and vertical scroll bars.

You can scroll through the list by doing one of the following:

¹ Click mouse button 1 on the arrow to scroll vertically one line, or if hor-
izontally, one character at a time.

¹ Press and hold mouse button 1 on the arrow and scroll through the list.

The shaded area between the two arrows in a scroll bar is called the
slider bar. It contains a slider box that moves toward the direction you
are scrolling. When the slider box touches the arrow, you have reached
the last item in that direction.

¹ Click mouse button 1 on the shaded area between the slider and the
arrow, to scroll vertically one page, or if horizontally, one frame in that
direction.

¹ Press and hold mouse button 1 while dragging the slider, to quickly scroll
through the viewing area.

Selecting Operations from Menus
The NetView for AIX program uses several kinds of menus to present choices to you.
These menus contain selections that help you access and perform network monitoring
and management operations.
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Using Pull-Down Menus and Cascade Menus
Pull-down menus are accessed by selecting an option from the menu bar. Cascade
menus appear when you select a choice from a pull-down menu or a context menu.
Figure 14 shows you what each menu looks like.

Figure 14. Pull-down and cascade menus present choices you can make.

Step 1. Click mouse button 1 to select the Edit pull-down menu.

Step 2. Look at the Create Submap menu selection.

Notice that the Create Submap menu selection is followed by an ellipsis (...).
The ellipsis indicates that if you select Create Submap, a dialog box will
appear, displaying information or requiring you to enter information.

Step 3. Look at the Modify/Describe menu selection.

Notice that the Modify/Describe menu selection is followed by a cascade
button, which looks like a right-facing arrowhead. The cascade button indi-
cates that additional menu selections are available for Modify/Describe.

Step 4. Click mouse button 1 on the Modify/Describe menu selection to see the
cascade menu with additional selections.

Step 5. Look at the Paste menu selection.

Notice that the Paste menu choice is not followed by an ellipsis or by a
cascade button. When you select Paste, the action is immediately per-
formed.

Note:  You might notice a ControlP direct access method for this function.

Step 6. Look at the Add menu selection.
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Notice that its text appears gray. When a menu selection is gray, it means
you can't perform that operation. Here are some reasons why a menu
selection might be gray:

¹ The menu item represents an action that doesn't apply to the selected
map symbols.

¹ There is a range of minimum and maximum number of selections for the
menu item, and you have not selected a number of symbols that falls
within that range.

¹ You need to select a symbol from a submap before you can use this
menu item.

¹ The operation requires a read-write map, not a read-only map.

¹ You do not have the necessary security authorization.

Using Pop-up Menus
Pop-up menus help you perform operations on individual symbols, objects, submaps,
event cards, or graphs. These menus are called pop-up menus because they “pop up”
on top of open windows. Sometimes, these menus are called context menus. For
symbols, objects, and submaps, the pop-up menus include operations from the menu
bar that are valid for your selection. Figure 15 shows a pop-up menu for a symbol.

Figure 15. Pop-up menus offer another way to perform operations on symbols.

To access a pop-up menu, follow these steps:

Step 1. Position the mouse pointer on a symbol or on the background area of a
submap.
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Step 2. Click mouse button 3.

You see a pop-up menu for the symbol or submap.

Step 3. To select a menu item, click mouse button 3 or 1 on a menu item from the
pop-up menu.

Step 4. To close the pop-up menu, click mouse button 1 on an area outside of the
pop-up menu border.

Using Dialog Boxes
A dialog box enables you to obtain information or change operational parameters. You
change information by using the mouse to work with the fields, lists, and buttons that
appear in the dialog box. If a particular option is not available, that option is grayed.

Some menu-item names on pull-down menus are followed by an ellipsis (...). The
ellipsis indicates that selecting the menu item produces a dialog box. For example, if
you select Edit..Modify/Describe..Map, the Map Description dialog box, shown in
Figure 16 appears.

1
2

3

3

3

Figure 16. Dialog boxes enable you to display and change information.

Working with Dialog-Box Lists
Many dialog boxes contain lists of items [1] you can select. Buttons [2] often appear to
the right of the list and represent operations you can perform on selected list items. If
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the list contains more items than can be displayed at one time, you can use the scroll
bars to scroll through all the items. The dialog box may contain fields [3] where you
can enter information or where the NetView for AIX program can display messages.

You can perform an operation on an item in the list by following these steps:

Step 1. Click mouse button 1 to select IP Map in the Configurable Applications list.
The IP Map selection is displayed in reverse video.

Step 2. Click on the Configure For This Map button.

The Configuration dialog box appears. Notice the message in the Messages
field in the bottom half of the Configuration dialog box. You can't make any
changes to the information in this dialog box, but someone with a read-write
map could change the settings of the fields you see here.

Step 3. Click mouse button 1 on the Cancel button to close the Configuration dialog
box.

Step 4. Click mouse button 1 on the Cancel button to close the Map Description
dialog box.

Using Buttons in a Dialog Box
Dialog boxes in the NetView for AIX program provide several kinds of buttons so you
can make choices and initiate operations. Table 1 on page 26 shows each button and
explains what it does.
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Gray Dialog Box Buttons:  You've already learned that menu selections can some-
times be gray, or unavailable. Buttons in a dialog box can also be gray sometimes.
Here are some reasons why:

¹ If the map you are looking at is read-only, some of the operations can't be per-
formed because they require a read-write map.

¹ Sometimes a particular value can be set only when the map, submap, or object is
created. Later, you can only look at it, not set or change it.

¹ Sometimes, information you enter must be reviewed for accuracy by applications
that will use it to monitor and report network conditions. In this case, the OK
button is grayed because you must first click mouse button 1 on the Verify button.

¹ You don't have the necessary authorization to perform a particular task.

Table 1. Buttons help you make selections on dialog boxes.

Button Name What It Looks Like What It Does

Push button OK Push buttons enable you to select executable
operations associated with a dialog box.

Radio button
Scaling

Zooming

Radio buttons enable you to select one of
several options. These buttons often occur in
pairs, so your choice is either/or.

Check buttons
Sunday

Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

Check buttons enable you to select more than
one option at the same time. You can check
all of them at once, if you want to.

Option buttons None
Row/Column
Point To Point
Bus
Star
Ring
Tree

Option buttons produce an option menu from
which you can choose a single item. All items
on the menu are mutually exclusive, so you
have to pick just one.
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 Getting Help
As you learn to work with the NetView for AIX program, it is reassuring to know how
quick and easy it is to get help. When you click on the Help pull-down menu, you'll see
several different help options:

 ¹ Indexes
¹ NetView for AIX Help
¹ NetView for AIX Library

 ¹ On Help
 ¹ Legend
¹ AIX Base OS InfoExplorer

 ¹ On Version

This section briefly describes each of those options and how you can get help for dialog
boxes.

 Indexes
Three index menu items cascade off the Indexes option. They are Applications, Tasks,
and Functions. The Indexes option is used for applications that are integrated with
NetView for AIX.

The Applications index is an index of applications integrated with NetView for AIX. The
Task index is an index of help topics associated with tasks you can perform through the
integrated applications. The Function index is an index of help topics associated with
each major function or capability of the integrated applications.

 On Help
The On Help menu option provides an explanation of the items on the current Help
menu, and information about other ways to access help.

 Legend
The Legend menu option provides a dialog box that displays the symbol types and
visual cues that can appear on an open map in NetView for AIX. This dialog box
explains the significance of the shapes, colors, and highlighting used on the graphical
interface.

NetView for AIX Help
NetView for AIX provides an easy way to access the information you need while per-
forming tasks. You can select this option at any time. Help is always available. To
give you an example, let's say you needed help in using the mail tool. Here's what you
do:

Step 1. Select NetView for AIX Help from the Help pull-down menu. A help window
opens with a Task Index listing topics from which you can select.

Step 2. Move the mouse pointer to an item in the list. The mouse pointer becomes a
hand pointer. The hand pointer means that whatever it is pointing to is
selectable.
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Step 3. Select Introducing the NetView for AIX Program. Another help window
opens.

Step 4. Select Using the Mail Tool.

The help window for Using the Mail Tool opens. From here you can select
the task for which you need help.

Step 5. Select Go Back..from the bottom of the DynaText window. Select File..Close
View to exit help.

 Try This

Try to find help for changing a symbol label.

NetView for AIX Library
All the information you need is right at your fingertips. NetView for AIX uses
DynaText** for displaying the online documentation. When you select the NetView for
AIX Library option, the DynaText Library window appears.

On the left side in the window is a list of Collections. Each collection contains a group
of books. When you select the NetView for AIX collection, a list of books belonging to
the NetView for AIX group is displayed on the right. From that list, you can select a
book to open.

Opening an Online Book
You can open a book one of two ways:

¹ Double-click mouse button 1 on the book you want to open.
¹ Click mouse button 1 to highlight the book and then click on the Open button.

The book opens with the table of contents on the left and the first page of the book on
the right.

Paging through the Book
Once a book is opened, you can page through it using the scroll bar located on the
right. Or, you can click on a topic from the table of contents and the book opens to that
topic.

Another way to get around inside a book is to use the hypertext links. Words high-
lighted in red are links to more information. Notice that the mouse pointer changes to a
hand when you move it over a highlighted word or phrase? Just click on the word or
phrase and the book opens to that page.

Using the Online Search Function
A search facility is also available. If you're not sure which book has the information you
need, you can select several books, using the Ctrl key, or select a collection name.
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Enter the text you're searching for in the Search field and then click on the Search
button. The results of the search can be:

¹ A list of books in which the search was successful

¹ The total number of occurrences of the search in a book displayed to the left of the
book title

¹ A question mark displayed to the left of the book titles in which the search was
inconclusive

You can also use the search function while in an opened book. Follow these steps:

1. Click mouse button 1 on Show Search Panel from the Search pull-down menu.

2. Enter the text you are searching for in the Search field.

3. Click on the Search button. The book opens to the page containing that text.

 Try This

Search for the text you are reading right now.

Getting Help for DynaText
If you need help using the online information, a Help button is available. DynaText
provides help for navigating, searching, using the table of contents, and a few other
items. If you forget how to get around while viewing a book, just click on Help. Give it
a try.

AIX Base OS InfoExplorer
The AIX Base OS InfoExplorer menu option provides access to RISC System/6000
software and hardware information.

 On Version
The On Version help option displays the currently installed version of applications
including the NetView for AIX applications.

Help for Dialog Boxes
Anytime you're looking at a NetView for AIX dialog box, you can be sure help is avail-
able. Each dialog box has a Help button. When you click on the Help button, an
information window is displayed. You'll see this information in the help:

 ¹ Title
¹ Purpose (why you would want to use the dialog box)
¹ Description of each section
¹ Steps necessary for performing the task
¹ Description of the fields
¹ Description of the buttons
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Exiting the NetView for AIX Graphical Interface
To exit the NetView for AIX graphical interface, take the following steps:

Step 1. Select Exit from the File pull-down menu of any submap window.

Step 2. Click on the OK button in the NetView for AIX Windows WARNING pop-up
window.

Step 3. Watch the NetView for AIX program's windows close.

Reviewing What You Learned
You've just completed your first session with the NetView for AIX program. Now you
know:

¹ How to start the NetView for AIX program
¹ Use a mouse to work with windows
¹ Get help when you need it
¹ Exit the NetView for AIX program.

When you're ready, continue with Chapter 2, “Understanding Network Management” on
page 31.
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Chapter 2. Understanding Network Management

Before you learn more about how the NetView for AIX program monitors and manages
a network, you need some background information about network management. This
chapter describes the network management environment and explains terms you'll see
throughout the rest of the book. Here's what you'll be reading about:

¹ “What Is Network Management?”
¹ “Understanding Managers and Agents” on page 32
¹ “Understanding MIBs” on page 33
¹ “Understanding Network Management Protocols” on page 36

What Is Network Management?
You know that a computer network is important to your company. It's the way informa-
tion is exchanged between groups, whether they are in the same building, across the
country, or even overseas. If these groups aren't able to get the information they need,
they can't do what they're supposed to do, and that affects all the other groups as well.
So it's essential that your company's computer network stay healthy.

What you might not know about your company's computer network is that:

¹ It's probably composed of hardware and software from many different vendors.
¹ It carries an enormous volume of traffic.
¹ There are many individual devices on the network.
¹ The operating status of these devices is continually changing.

Figure 17 on page 32 shows what a complex network might look like.
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Figure 17. Computer networks are complex.

As you can see from this figure, there are many squares, circles, and diamonds. Each
square represents a computer, each circle represents a network, and the diamonds rep-
resent connectors. The lines show how they are connected. This could be a busy
network. There has to be some way to watch and control network activities to make
sure all parts of the network do the job they're supposed to do.

That's where network management software comes in. Basically, network management
software has to perform the following tasks:

¹ Discover the devices in the network.
¹ Collect and store data about network conditions.
¹ Issue and respond to notifications about network conditions.
¹ Issue commands that cause actions at network nodes.

Now, let's learn about the parts of a network management system.

Understanding Managers and Agents
Because we're talking about network management, it makes sense that there should be
a manager somewhere in the network.
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 Key Concept

A manager is a software application that monitors and controls a network. A
manager collects, processes, stores, and displays network data. The NetView for
AIX program is a manager.

Just as your manager gives you assignments to complete, a network manager requests
that certain tasks be performed by agents that are part of the network.

 Key Concept

An agent is a software application that is responsible for reporting on and main-
taining information related to one or more devices on the network. An agent gives
network information to a manager.

 Understanding MIBs
The physical and logical characteristics of a network device make up its Management
Information Base (MIB). But the MIB isn't really a database. A MIB is a collection of
many pieces of information, called MIB objects, that are located on the network device.
The MIB objects can be accessed and sometimes changed by the agent at the manag-
er's request. This is how the NetView for AIX program manages network devices.

MIBs Supported by NetView for AIX
The NetView for AIX program uses the following kinds of MIBs:

Standard MIB All devices that use SNMP to communicate are also
required to use a set of common network device defi-
nitions, which is the MIB. The standard MIB object defi-
nitions, MIB-I and MIB-II, enable SNMP agents to
monitor network devices that use SNMP.

Enterprise-specific MIB In addition to using the standard MIB, many products
have MIB objects that were developed specifically for
managing that product, for example, a router or a soft-
ware application. IBM has enterprise-specific MIBs, too,
for products such as the 6611 Router. These MIBs must
follow certain definition standards, just as other MIBs
must, to ensure that the information they contain can be
accessed and modified by agents. The NetView for AIX
program uses these MIBs to monitor and control vendor
devices.
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How MIB Objects Are Named
A MIB object gets its name from its position in a hierarchy called a tree structure.
Think about a tree turned upside down; its trunk would be the main branch from which
all other branches fan out. In turn, each of those branches has smaller branches
spreading out, and so on, until the smallest twigs end in leaves.

Now, suppose you wanted to trace a path from the main trunk to one particular leaf,
something like Figure 18.

Large Branch 3

Medium Branch 2

Medium 
Branch 1

Small 
Branch 1

Small 
Branch 2

Small Branch 3

Twig 3

Twig 1
Twig 2

Leaf 2

Leaf 1

Large 
Branch 1

Large Branch 2

Figure 18. Tracing a path from top to bottom provides a MIB object ID.

So, using periods to separate each branching point, the name of this MIB object would
be:

.largeBranch3.mediumBranch2.smallBranch3.twig3.leaf2

This looks like a complicated name, doesn't it? Actually, it's a good way to show how
one MIB object relates to all other MIB objects.

Now, look at the tree structure shown in Figure 19 on page 35. This is the actual tree
structure used by all organizations that use MIBs for network management. You can
see where the paths for standard and enterprise-specific MIBs diverge. This figure
doesn't show the complete path to any specific MIB object ID, but it does gives you an
idea how MIB objects get their names.
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Figure 19. Both standard and enterprise-specific paths are shown in this tree structure.

Each branch is identified by not only a number, but also by a name. Don't worry about
understanding the names; as you work with the NetView for AIX program you'll learn
more about them.

Here's an example of a standard MIB object ID, shown in both formats:

.iso.org.dod.internet.mgt.mib-2.ip.ipForwarding

.1.3.6.1.2.1.4.1

 Try This

Use Figure 19 to trace part of the path for the above MIB object ID.
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Understanding Network Management Protocols
You probably realize that you have different ways of communicating, depending on your
audience. For example, you interact differently with close friends than you would
interact with someone you don't know well, or with your boss. In each case, there is a
set of rules, often unspoken, that govern interactions among people. These sets of
rules are called protocols.

The NetView for AIX program uses protocols, too. Protocols help the NetView for AIX
program, as a manager, communicate with the agents in its network. The agents, in
turn, use protocols to communicate with the network devices whose status they
monitor.

 Key Concept

A protocol is a set of rules that determine how individual network devices commu-
nicate with each other.

In the world of network management, there are several protocols most commonly used.
Table 2 on page 37 lists these protocols and describes how they are used to monitor
and manage networks.
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Both the SNMP and CMIP protocols provide commands that managers can use to com-
municate with agents about the status of network devices. These protocols both use
the Get and Set commands as follows:

Get Asks the agent for the current value of one of a network device's MIB objects,
for example, requesting a description of a particular network device.

Set Changes the value of one of a network device's MIB objects, for example,
updating information about the network device whose description was pro-
vided by a Get request.

Some of the NetView for AIX applications and menu items issue these commands and
display the results through the NetView for AIX program's graphical interface. You
might not need to use these commands directly. But now you have some idea how
information is exchanged between managers and agents.

Table 2. Network management protocols enable communication among network devices.

Protocol name Protocol
acronym

What the protocol does

Transmission Control
Protocol/Internet Protocol

TCP/IP A set of communications protocols that sup-
ports peer-to-peer connectivity functions for
both local and wide-area networks.

Simple Network Management
Protocol

SNMP SNMP enables managers to ask agents to
retrieve and change information about network
devices. The NetView for AIX program uses
SNMP to manage TCP/IP networks. Because
SNMP has low network overhead, it's an inex-
pensive way to gather network statistics. It is
also ideal for real-time monitoring, which is
how you'll be using the NetView for AIX
program.

Open Systems Interconnection OSI An open system is one that complies with
industry-wide standards for communication.
Open systems can be connected to other open
systems that comply with the same standards.

Common Management Infor-
mation Protocol

CMIP CMIP was designed to manage OSI networks,
but it can also be used in other kinds of net-
works.

Common Management Infor-
mation Services

CMIS A suite of operational and notification services
used for the management of systems. CMIP
is the CMIS protocol.

Common Management Infor-
mation Protocols over TCP/IP

CMOT The NetView for AIX program supports CMOT,
which means it can monitor and manage net-
works that use the CMIP protocols in combina-
tion with TCP/IP.
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Reviewing What You Learned
Before you learn more about the NetView for AIX program, see if you can define these
terms:

 ¹ Manager
 ¹ Agent
 ¹ MIB
 ¹ Protocol
 ¹ SNMP
¹ MIB object ID

 ¹ Tree structure

If you need to look back at the chapter, that's okay. When you're ready, go on to
Chapter 3, “Working with Maps” on page 39.
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Chapter 3. Working with Maps

So far, you've learned some basic concepts about the NetView for AIX program's
graphical interface and about network management. Now, it's time to focus on how the
NetView for AIX program displays network information so you can monitor and manage
your network more efficiently. You'll learn about the following topics in this chapter:

¹ “Learning about Objects and Symbols”
¹ “How Objects and Symbols Interact” on page 44
¹ “Learning about Maps and Submaps” on page 45

Learning about Objects and Symbols
You probably don't spend much time thinking about your workstation. After all, it just
sits on your desk; you use it to do your job. But take some time now to think about its
physical characteristics, as shown in Figure 20.

SIZE SHAPE

COLOR WEIGHT

Figure 20. You define your workstation by its physical characteristics.

These characteristics are things most people would notice about your workstation.
However, to the NetView for AIX program, these physical characteristics are not impor-
tant, because they don't help the NetView for AIX program do its job. The NetView for
AIX program monitors and manages your workstation and other network devices by
processing logical, not physical, information about those devices. To represent that
information and those devices, the NetView for AIX program uses objects and symbols.
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What Is an Object?
An object isn't tangible; you can't see it or touch it. Here's an official definition:

 Key Concept

An object is a group of characteristics that define a distinct physical or logical entity
in the database, for example, a workstation, a router, a software application, or a
network.

Suppose you decided to refer to your workstation as “that heavy gray box on my desk”
instead of as “my workstation.” You'd be defining your workstation by its tangible char-
acteristics. The NetView for AIX program defines your workstation by characteristics,
too, but not the same ones you use. Figure 21 shows some of the characteristics that
define your workstation to the NetView for AIX program.

NetView for AIX Your
Workstation

isWorkstation
isIP
isSNMPSupported
Name of interface
Status of interface

Figure 21. NetView for AIX uses these and other characteristics to define your workstation.

You can see that these characteristics don't match the ones you usually use to describe
your workstation. But for the NetView for AIX program, they're perfect. The NetView
for AIX program stores this information in a database and uses it to monitor and
manage your workstation. It does the same for other network devices.

The only way you can “see” an object is by looking at a symbol or symbols that were
created to represent that object. There can be more than one symbol representing the
same object, because there can be more than one perspective from which to view an
object. For example, an object might have several addresses, each one represented
by a separate symbol, or the object might have connections to more than one protocol.
Each of those connections would be represented by a separate symbol. But you'll
never see one symbol representing several different objects. Figure 22 on page 41
shows how objects correspond to symbols.
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A.

B.

C.

C.

B.

A.

Start With Your Workstation

Your Workstation

Your Workstation

NetView for AIX
Object Definition

NetView for AIX
Object Definition

Icon symbols representing 
your workstation in an
NetView for AIX submap

Icon symbols representing 
your workstation in an
NetView for AIX submap

isWorkstation
isIP
isSNMPSupported
name of interface
status of interface

isWorkstation
isIP
isSNMPSupported
name of interface
status of interface

Start With The Icon
Representing Your Workstation

Figure 22. Objects are represented by symbols.

What Is a Symbol?
A symbol is a visual representation of an object. Multiple symbols can represent a
single object. These objects are represented on submaps by symbols. See “Under-
standing Object Attributes” on page 44 to read about object fields.

 Key Concept

A symbol is a visual representation of an object.

The NetView for AIX submap window displays symbols. The two basic types of
symbols are Icon symbols and Connection symbols.

Icon symbols, have distinctive shapes with bitmap drawings in the center. Icon symbols
can represent actual physical devices on the network, for example, your workstation, or
logical devices such as a software application. They can also represent locations, such
as a country or the third floor of a building. Sometimes, icon symbols have labels
attached to them, displaying the name of the object represented by the symbol.
However, if there are too many symbols on the submap, the labels won't be shown.

Connection symbols, are straight lines that join icon symbols. Connection symbols rep-
resent the connections between network devices.
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 Try This

Select Legend from the Help pull-down menu to see the full range of symbols used
by the NetView for AIX program. Scroll through the legend to see the different
shapes and bitmaps available.

Color Conveys Symbol Status
You've probably seen symbols on a submap change color, for example, from red to
green or from green to yellow. That's the NetView for AIX program's way of telling you
that the network device represented by the symbol has changed somehow. Table 3
lists the status colors and their meanings.

Table 3. These colors identify the status of network devices.

Status Meaning Icon Color Connection
Color

Unknown The object's status can't be deter-
mined.

Blue Black

Normal The object is in a normal opera-
tional state.

Green Black

Marginal The object has at least some
unsatisfactory condition.

Yellow Yellow

Critical The object is not functioning. Red Red

Unmanaged This object's status is not being
reported to the NetView for AIX
program, so you don't have to
worry about it right now.

Wheat Black

Acknowledged This object's status is either mar-
ginal or critical, but you can ignore
its status until it resumes normal
operation.

Dark Green Black

UserStatus1 Ask your system administrator if
this status has been defined to
mean something specific for your
network.

Pink Black

UserStatus2 Ask your system administrator if
this status has been defined to
mean something specific for your
network.

Violet Black

 Try This

If you need to know what a particular color represents and you don't have this
manual handy, select Legend from the Help pull-down menu and look at the
section called Status States and Colors.
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Symbols Function in One of Two Ways
In the NetView for AIX program, when you double-click on a symbol, it functions in one
of two ways:

 Key Concept

Explodes
The symbol opens a submap. Most symbols you see are explodable.

Executes
The symbol immediately starts an application.

Executable symbols are surrounded by a box, so they resemble a large
button. You can double-click on the executable symbol to start an appli-
cation, for example, one that gathers network traffic statistics.

 Try This

Select Legend from the Help pull-down menu to find out what an executable
symbol looks like. Have you noticed any executable symbols on the submaps
you've seen so far? Ask your system administrator if one was added to your
submap. If so, continue with the next task. If not, go to “How Objects and
Symbols Interact” on page 44.

Use the following task to understand how symbols function.

Before You Begin

¹ The Root submap must appear in the submap window.
¹ The Root submap must contain an IP Internet symbol.

Step 1. Double-click mouse button 1 on the IP Internet symbol on the Root submap.

Based on what you've just read, is this an explodable or an executable
symbol? How do you know?

The submap you see now probably contains many symbols. Do you see an
executable symbol on this submap? How can you tell that it's executable?

Step 2. Double-click mouse button 1 on the executable symbol. What happens?

Step 3. Click mouse button 1 on the OK button to close the pop-up window that
appeared when you double-clicked mouse button 1 on the executable
symbol.
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How Objects and Symbols Interact
Now that you know what objects and symbols are, it's time to learn more about how
they interact. Let's work with a symbol that represents an object defined by the
NetView for AIX program as a router.

 Key Concept

A router is a device that routes data between networks.

Here's what a router symbol looks like:

Look at the internet submap in the submap window and find a symbol that looks similar
to this one.

Understanding Object Attributes
Each object's characteristics are contained in fields that make up the object. Each field
contains a piece of information about the object, such as:

¹ The object's name
¹ The object's IP address
¹ Whether the object supports SNMP
¹ The type of hardware the object represents
¹ The object's status

The values in the fields that make up the object are called the object's attributes. You'll
be seeing the object attributes for the router on your submap in “Getting a Description
of an Object.”

Understanding Capability Fields
An important type of object attribute is the capability field. A capability field can take
the values True or False, and indicates whether the object has a certain characteristic,
or capability. In the list of object attributes above, the item Whether the object supports
SNMP is a capability field.

Capability fields govern the kinds of actions you can take while working with an object.
When you select a symbol on a submap, the capability fields of its associated object
determine which menu options are available for you to use. You'll be seeing the capa-
bility fields for the router on your submap in “Getting a Description of an Object.”

Getting a Description of an Object
You already know that the NetView for AIX program doesn't describe objects the way
you do. Now that you know something about attributes and capability fields, you'll be
able to understand the NetView for AIX program's way of describing objects. Using the
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following fastpath method will provide you with attributes dialog using the context menu
of any object in a submap.

Step 1. Click the third mouse button over any object in a submap.

Step 2. Select Edit in the context menu.

Step 3. Choose Description to get the attributes dialog.

Learning about Maps and Submaps
Objects and symbols are important parts of the NetView for AIX graphical interface, but
they aren't the whole story. To group objects and symbols so they present meaningful
network information, the NetView for AIX program uses maps and submaps. This
section explains how maps and submaps work.

What Is a Map?
The NetView for AIX program uses maps to maintain customizable views of the data-
base.

 Key Concept

A map is a named collection of objects, symbols, submaps, and their relationships.

What Is a Submap?
There are usually so many objects in the NetView for AIX object database that you'd
never be able to look at all of them at one time. If all the symbols representing all the
objects in the database were displayed in one window, none of them would be larger
than a pinhead, which wouldn't make them very easy to see or use. Of course, there's
a better way to look at parts of a map.

 Key Concept

A submap displays a subset or view of a map. Think of a submap as a window
into the map database. A group of submaps presents views from many perspec-
tives. Submaps are organized in a hierarchy according to the level of the view
they present of the map.

The first submap you see when the NetView for AIX graphical interface opens a map is
the home submap. Think of this submap as your starting point for exploring the
submap hierarchy.

Every map has a home submap. Often a map's home submap is the Root submap.
This is the default, and it's what you see on the NetView for AIX graphical interface
unless the default has been changed. But any submap can become the home submap.
For example, you might want the home submap to be the submap you use most often
to monitor the network, so it will be the one you see first every time you open this map.
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The Root submap generally displays only a few symbols. Each symbol represents a
different network management protocol, so you can tell at a glance how many protocols
are represented in the map.

Usually, there is an IP Internet symbol on the Root submap. Is there one on yours? If
not, ask your system administrator if you can open another map that has this symbol,
so you can continue with the tasks in this chapter.

Sizing Submap Presentation
Submap presentation enables you to choose how each submap presents symbols and
background graphics. You can choose between scaling and zooming for each specific
submap.

 Scaling
Scaling enables you to display all the submap information within the submap window.
All displayed symbols and the background graphics are sized to fit within the submap
window. Scaling is the default setting when a submap is created.

 Zooming
Zooming enables you to display a close-up view of the submap. Scroll bars automat-
ically appear when only a portion of the submap fits into the viewing area. You can use
the zoom feature in two ways:

¹ Set a zoom factor to determine the extent to which you zoom into the view of the
submap. The default zoom factor is one .

¹ Use quick zoom to draw a boundary box around the area of the submap to be
zoomed.

To set a zoom factor :

1. Select Modify/Describe  from the Edit pull-down menu.
 2. Select Submap .

3. Select the Zooming button and use the slider bar to select a zoom factor between
1.0 and 10.0.

4. Choose OK to activate the selected zoom factor.
 5. Select OK.

To use quick zoom :

1. Position the mouse cursor in the upper left corner of the area to be zoomed.
2. Press and hold down the Shift key and mouse button 1. Drag the mouse to draw a

box around the area to be zoomed.
3. Release mouse button 1, then the Shift key. If you release the Shift key first, the

objects are selected instead of zoomed.
4. To return to the original scale, press and hold down the Shift key and click mouse

button 1.
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Exploring the Submap Hierarchy
There are four levels in the IP submap hierarchy. These levels represent different per-
spectives on the information in the map database. Here's a list of the four levels, which
are described in more detail in the next task. The levels may be different for a non-IP
hierarchy.

 ¹ Internet level
 ¹ Network level
 ¹ Segment level
 ¹ Node level

You should now be looking at the Root submap. Your Root submap might display
more than one symbol. As long as it contains an IP Internet symbol, it's fine for our
purposes.

Looking at this submap only, the colors of the symbols can tell you whether there are
problems or potential problems. However, you can't see exactly where the problems
are located. You'll have to explore the submap hierarchy in more detail.

Step 1. Double-click mouse button 1 on the IP Internet symbol on the Root submap.

Step 2. Look at the submap that appears in the submap window. This submap dis-
plays your network at the highest level, called the internet level. An internet
is a group of connected networks. The submap contains symbols for devices
and connections on several connected networks.

Step 3. Notice that a RootMap icon now appears in the area on the left side of the
submap window, called the submap stack.

 Key Concept

Icons in the submap stack represent submaps you've already visited, or opened.
These submaps are still open, but are not currently displayed in this submap
window. In this case, you've already visited the RootMap, so that submap is still
open, but it isn't displayed right now.

Step 4. Notice that the Navigation Tree window contains the RootMap icon and an IP
Internet icon. Each time you visit a new submap, its corresponding icon
appears in the Navigation Tree in the correct relationship to other visited
submaps.

Step 5. Click mouse button 1 on the RootMap icon in the submap stack (to the left of
the submap). The Root submap, containing the IP Internet symbol, is dis-
played.

Step 6. Look at the Navigation Tree window. The blue border has moved from the IP
Internet icon to the RootMap icon, showing that the Root submap is currently
displayed. The Navigation Tree window shows that the internet-level submap
is still open, because you've already visited it, although it is not currently dis-
played in a window.
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Step 7. Notice that the IP Internet icon is displayed in the area under the submap
area, called the child submap area. This icon represents a submap you've
visited that is one level lower than the currently displayed submap. This
lower-level submap is still open, but it is not currently displayed in a window.

Step 8. Click mouse button 1 on the IP Internet icon in the child submap area to
display the internet-level submap. Look at this submap. Do you see the
router you worked with in “Getting a Description of an Object” on page 44?

Step 9. Double-click mouse button 1 on a network symbol:

9.67.160

IP

The next lower level submap, a network-level submap, is displayed. This
submap shows one network from among the several networks that were
represented on the internet-level submap. Find the router on this submap,
also.

Step 10. Double-click mouse button 1 on a segment symbol:

Segment1

A segment-level submap is displayed. This submap displays one particular
part, or segment, of the network shown on the network-level submap. Once
again, look for the router on this submap.

Step 11. Double-click mouse button 1 on the router symbol

to display its node-level submap. This submap displays the interfaces, or
connections to a network, that are attached to the router.

Getting a Description of Your Network
Use this exercise to get a description of the components of your network.

Step 1. Click mouse button 1 on the RootMap icon in the submap stack to display the
Root submap.

Step 2. Click mouse button 1 on the IP Internet symbol to select it.

Step 3. Select Modify/Describe from the Edit pull-down menu.

Step 4. Select Object from the Modify/Describe cascade menu.

The Object Description dialog box appears.

Step 5. Click on IP Map in the Object Attributes list.

Step 6. Click on the View/Modify Object Attributes button.

The Attributes for Object dialog box appears. It shows how many IP net-
works, segments, nodes, interfaces, and gateways or routers are contained in
this particular submap hierarchy.

48 NetView for AIX V4R1 User's Guide  



Step 7. Click mouse button 1 on the Cancel button to close the Attributes for Object
dialog box.

Step 8. Click mouse button 1 on the Cancel button to close the Object Description
dialog box.

Step 9. Click mouse button 1 on the icon for the internet-level submap in the child
submap area.

Step 10. Click mouse button 1 on the icon for the network-level submap in the child
submap area. That's where you need to be for the next task.

Locating and Displaying a Submap
Suppose you want to locate and display a particular submap.

Step 1. Select Submap from the Locate pull-down menu.

The Submaps in Map dialog box appears. This dialog box contains a list of
the submaps contained in the open map. The numbers to the left of the
submap names represent the level of each submap in the IP hierarchy, as
follows:

¹ (0) Root level submap
¹ (1) Internet-level submap
¹ (2) Network-level submap
¹ (3) Segment-level submap
¹ (4) Node-level submap

Note:  You now have the option to sort your submaps by Name or Layout.
From the Submap in Map dialog box, simply click on Name or Layout to sort
your submaps accordingly.

Step 2. Scroll through the list, looking for a node-level submap. Select the submap
by clicking mouse button 1 on it.

Step 3. Click mouse button 1 on the Open Submap button.

The submap opens in a separate window and appears in the foreground. If
you open a submap that is already open, the submap moves to the front.
The active window is always in front of the other windows.

Notice where the submap appears in the Navigation Tree window. This
submap is part of the hierarchy of open submaps.

Did you notice also that there are two submap icons in the Navigation Tree
window that have blue borders? That's because you're visiting both of them
at the same time. Remember, both submaps are currently open and dis-
played. You selected one by going through the submap hierarchy, and the
other by using the Locate..Submap menu operation.

Step 4. Click mouse button 1 on the Close button in the Submaps in Map dialog box
to close it.

Step 5. Move the separate submap window to another part of the desktop. Make
sure you can see both the submap stack and the child submap area in the
submap window. The child submap area should contain a segment icon.
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Step 6. Click mouse button 1 on the segment icon in the child submap area of the
submap window displaying the network-level submap. Look at the contents
of the child submap area now. You should see the icon for the node-level
submap you just opened, along with icons for any other node-level submaps
that are currently open.

Step 7. To close the separate submap window, select Close from the system menu.

Notice that, although the separate submap window closes, there is still an
icon in the Navigation Tree window for this submap. The icon no longer has
a blue border. That's because the submap is still open, though not displayed.

 Try This

Another way to open a submap is to use the View..Open Submap menu operation.
Try it!

Here's a way to close both the window in which a submap is displayed and the submap
itself.

Step 1. Press and hold mouse button 3 on the submap icon in the Navigation Tree
window. A context menu appears.

Step 2. Select Close Submap, Descendants, and Windows from the context menu.
The submap icon disappears from the Navigation Tree window. The submap
is now closed.

Locating Objects in the Submap Hierarchy
Now that you've seen that an object can appear in many places in the submap hier-
archy, you might be thinking that finding a particular object somewhere in all the levels
of submaps is like looking for a needle in a haystack. Actually, the NetView for AIX
program gives you several ways to locate an object. This exercise shows you what to
do:

Step 1. Select Objects from the Locate pull-down menu.

Step 2. Select By Attribute from the Objects cascade menu.

The Locate by Attribute dialog box appears.

Step 3. Click mouse button 1 to select IP Hostname from the list in the Object Attri-
butes field.

Notice that the dialog box now contains a field, labeled Regular Expression
(or substring), where you can type the hostname you want to search for.

Step 4. Move the mouse pointer to the Regular Expression field and click to put a
cursor at the beginning of the field.

Step 5. Type the fully qualified hostname of the router you've been working with in
the Regular Expression field.

Step 6. Click on the Apply button to begin the search.
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Look at the section of the dialog box that contains the Located and High-
lighted field. This field should have at least one entry in it, and possibly more
than one. If you're wondering why there's more than one entry in this field,
keep reading.

 Key Concept

The Locate operation lists every submap within the open map that contains the
symbol you want to locate. A symbol can appear on more than one submap if the
object it represents is being shown from different perspectives within the network.

For example, suppose the list in the Located and Highlighted field looks like
this:

tardis.raleigh.ibm.com [ IP Internet : tardis ]
tardis.raleigh.ibm.com [ IPMap - Network:9.67.160 : tardis ]
tardis.raleigh.ibm.com [ IPMap - Segment:9.67.160.Segment1 : tardis ]
tardis.raleigh.ibm.com.tr0 [tardis : tr0; ]
tardis.raleigh.ibm.com.tr1 [tardis : tr1; ]
tardis.raleigh.ibm.com.en0 [tardis : en0; ]

This means that the router tardis is represented by symbols on four different
submap levels: IP Internet, network, segment, and node. The node-level
submap contains three interfaces, represented in the example above by tr0,
tr1, and en0.

Step 7. Read the information in the Messages field at the bottom of the Locate by
Attribute dialog box. This information tells you how many symbols were
found and explains how to either select the objects or display the submaps
where the symbols were found.

Step 8. Click mouse button 1 on an entry in the Located and Highlighted list box to
select the entry. The text is displayed in reverse video.

Step 9. Click mouse button 1 on the Open button to open the submap where the
selected symbol is located.

The submap opens in a separate window. Can you see the symbol? The
symbol label should appear in reverse video, which means that the symbol
has been highlighted.

 Key Concepts

Highlighting The NetView for AIX program uses highlighting to indicate the
results of performing Locate operations on NetView for AIX
objects.

Selecting You click mouse button 1 on symbols to choose objects on
which you want to perform operations.

Step 10. Select Close from the system menu in the separate submap window to close
this window.
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Step 11. Click mouse button 1 on the entry displayed in reverse video in the Located
and Highlighted list box in the Locate by Attribute dialog box. The text is
displayed normally, surrounded by a dashed line that indicates this is the
current position of the cursor in the list.

Step 12. Click mouse button 1 on a different entry in the Located and Highlighted field
of the Locate by Attribute dialog box. Now, the new entry is displayed in
reverse video, surrounded by the dashed line.

Step 13. Click mouse button 1 on the Select button. The symbol you clicked on has
just been added to the NetView for AIX program's selection list.

 Key Concepts

Selection list A list of selected objects for the open map that you can use as
input to various other NetView for AIX operations, such as moni-
toring or collecting network statistics. What's in the selection list
determines whether pull down menu items are available or
grayed.

Selection name A unique name for each object that identifies the object to the
NetView for AIX program. Sometimes the object's selection
name and symbol label are the same.

Step 14. Click mouse button 1 on the Close button to close the Locate by Attribute
dialog box.

Step 15. Select Selected Objects List from the Locate pull-down menu.

The Selected Objects dialog box appears. In the Selected Objects field, you
should see the name of the symbol you just selected from the list in the
Locate by Attribute dialog box. The NetView for AIX program has stored this
entry in its selection list so it will be available for further processing.

 Try This

Use the Locate..Objects..By Selection Name or Symbol Label operation to locate
your workstation. First, you'll need to know the selection name or symbol label for
your workstation. If you don't know, ask your system administrator.

How Symbol Status Travels the Submap Hierarchy
You already know that color conveys the operational status of a symbol on a submap.
You've also learned that submaps are organized in a hierarchy. Let's take these ideas
one step further.
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 Key Concept

The status of a symbol doesn't affect only the submap where the symbol is dis-
played. A symbol's status can be propagated, or passed, up to its parent object
on a higher-level submap, where it causes the parent object's color to change.

Let's use the router as an example. You saw a node-level submap that showed the
router's interfaces to the network. If one of those interfaces is down for some reason,
its submap symbol will be red. The fact that one of its interfaces is down could be
propagated up to the next submap level, the segment submap, by showing the router
symbol there as yellow. The router symbol on the network-level submap might also be
displayed as yellow, depending on how the status is being propagated.

If all of the router's interfaces were up, the submap symbols would all be green, and the
router's propagated status on the segment-level submap would result in a green symbol
being displayed there, and so on up to the internet-level submap.

There are certain rules affecting status propagation, but you don't need to be concerned
with them right now. As long as you understand that symbols use color to convey
status, and that sometimes a symbol's status is influenced by the status of symbols in
its child submaps, that's enough for now.

Working with Map Snapshots
Just as you take snapshots of family, friends, or vacation trips so you can remember
how they were, the NetView for AIX program provides a way to create snapshots of
how your network looks at a particular moment in time.

 Key Concept

A snapshot is an image of a map that preserves the status of all symbols and
contains all submaps that existed in the map at the time the snapshot was created.

Snapshots can help resolve network problems by letting you compare current, real-time
conditions with a picture of how the network looked before the problem occurred.

Snapshots are read-only; that means you can't change the way symbols are placed on
them. Snapshots are static; that is, they don't receive updates from the NetView for
AIX program about the status of network devices.
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Opening a Snapshot
Because you're working with a read-only map right now, you won't be able to create a
map snapshot. But you can open an already-created snapshot to see what it looks like.
Follow these steps:

Step 1. Select Map Snapshot from the File pull-down menu.

Step 2. Select Open from the Map Snapshot cascade menu.

The Available Snapshots dialog box appears.

Step 3. Click mouse button 1 on the name of a snapshot.

Step 4. Click mouse button 1 on the Open Snapshot button.

When you open a snapshot, the home submap at the time the snapshot was
taken is displayed.

Step 5. Double-click mouse button 1 on the IP Internet symbol in the snapshot to
display the IP Internet submap.

Notice that the name of the snapshot is displayed in the status line. That's
how you tell the open snapshot from the open map.

Step 6. Move the mouse pointer to the Navigation Tree window. Use the slider bar
at the bottom of the window to scroll to the right. You should see two icons,
representing the two open submaps in the snapshot.

 Key Concept

The Navigation Tree window displays the hierarchy of open submaps within a
snapshot, in addition to displaying the hierarchy of open submaps within an open
map.

Step 7. Keeping the snapshot open, move the mouse pointer back to the NetView for
AIX submap window.

Step 8. Display the IP Internet submap in the NetView for AIX submap window.
Depending on where you are in the submap hierarchy, you might have to
click on an icon in the child submap area or in the submap stack.

Step 9. Click mouse button 1 on a symbol in the IP Internet submap in the NetView
for AIX submap window. The symbol becomes highlighted.

Step 10. Move the mouse pointer back to the snapshot version of the IP Internet
submap.

Is the corresponding symbol highlighted on the snapshot?
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 Key Concept

Highlighting symbols applies only to the submap or snapshot in which you highlight
them. It does not apply to both. In other words, if you highlight a symbol on a
submap, the same symbol isn't highlighted on the snapshot.

Step 11. Select Map Snapshot from the File pull-down menu in the NetView for AIX
submap window.

Step 12. Select Close from the Map Snapshot cascade menu.

The map snapshot closes.

The NetView for AIX submap window stays the same.

Reviewing What You Learned
Take a few minutes now to review what you've learned in this chapter. You should
understand:

¹ What an object is
¹ What a symbol is
¹ What object attributes are
¹ What capability fields are
¹ How to get an object description
¹ What a map is
¹ What a submap is
¹ How to size submaps
¹ What the four levels of the submap hierarchy are
¹ How to locate and display a submap
¹ How to locate an object in the submap hierarchy
¹ How symbol status travels the submap hierarchy
¹ What a map snapshot is, and how to open one

If there's anything on this list that you don't understand, review the material before you
go on. Once you're ready, continue with Chapter 4, “Using Events and Workspaces”
on page 57
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Chapter 4. Using Events and Workspaces

You've already learned that the NetView for AIX program uses color to convey the
status of network objects. In this chapter, you'll learn about events, another way the
NetView for AIX program notifies you of network changes. You'll also learn how to
group events in windows called workspaces.

This chapter contains the following sections:

¹ “Learning About Events”
¹ “Working with the Event Display Application” on page 58
¹ “Using Workspaces” on page 62
¹ “Looking at Events in the Event Log” on page 70

Learning About Events
You probably know someone who always seems to know what's happening—at work,
or among your friends. Somehow, this person receives lots of information from many
sources. The NetView for AIX program also receives information, in the form of events
and traps from many sources on the network.

 Key Concepts

Events Events are messages about what's happening on the network.
NetView for AIX sends events when it discovers changes in the
network or when an SNMP trap is received from a managed node.

Traps Traps are unsolicited messages from managed nodes in the network.
They are generated by SNMP agents for network devices and sent to
inform NetView for AIX of changes on the agent systems. Unsolicited
traps are sent to this management station only if the SNMP agents
have been configured to do so.

If an SNMP trap is received, NetView for AIX generates an event and sends it to appli-
cations registered to receive it. The event cards that you see in the control desk is one
of the applications that receives events. The information you see in the event cards is
user-defined information added to the trap by NetView for AIX.

Working with Events
The NetView for AIX program provides two ways for you to work with events.

¹ The Event Display application dynamically displays selected events as they are
received from the network during the current NetView for AIX session. See
“Working with the Event Display Application” on page 58 for more information.

¹ The Event History application displays events that were received by the NetView
for AIX program and stored in a log file. See “Looking at Events in the Event Log”
on page 70 for more information.
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Why Events Are Generated
Events are generated to notify the NetView for AIX program of changing conditions in
the network. Some of the conditions that cause an event to be generated are listed
here:

¹ A network device is functioning inconsistently causing the SNMP agent to send an
SNMP trap to NetView for AIX.

¹ A network device's status changed in some way, for example, from up to down.

¹ A network device's configuration changed, for example, a new interface or con-
nection, has been added or deleted.

¹ An SNMP agent received a trap from one of the devices it manages and is for-
warding it to the NetView for AIX program.

¹ A threshold set for the frequency of a specified network activity was exceeded.

Working with the Event Display Application
The Event Display application is started in the control desk window when the NetView
for AIX program is started. This application displays all events that are filtered for
display. Some of these events are forwarded to the NetView for AIX program from the
attached network. Others are internal events that are generated by NetView for AIX
processes.

The Events application displays information about what's happening in the network
being monitored and managed by the NetView for AIX program. The display changes
continuously as new events are received and the oldest events are removed from the
display.

The NetView for AIX program provides two ways to display event information. The one
you see by default on the graphical interface is the card format. You can also display
events in a list. The card format displays complete information about an event, while
the list provides a summary.

Displaying Events in Card or List Format
To change the event display from the default card presentation to a list, follow these
steps:

Step 1. Click mouse button 1 to select the View operation on the menu bar in the
Events Display Application Main workspace.

Step 2. Select List from the pull-down menu.

The card display changes to a list. Watch as the list is updated. The most
recently received events are displayed at the bottom of the list.

Step 3. Now, change the display back to cards.

Step 4. Watch as the card format display is updated. Are the most recently received
events displayed at the front or back of the card stack? Right; they're dis-
played at the front.
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There's another way to change the event display from cards to a list:

Step 1. Place the mouse pointer on the event cards in the Control Desk window.

Step 2. Click mouse button 3 to display the Work Menu.

Step 3. Move the mouse to select Switch List<-->Cards from the Work menu.

The display changes from cards to a list.

Step 4. Now, use the Work Menu to change the list back to the card display.

 Try This

To freeze the event display, click mouse button 1 on the Freeze button at the
lower-left corner of the Event Display window. To resume dynamic update of the
event display, click mouse button 1 on the Freeze button again. Although the
event display is frozen, events continue to be received.

What the Event Card Format Tells You
Event cards are convenient ways to display important information about what's hap-
pening on the network. Figure 23 shows the event card format.

Figure 23. Event cards display information about network conditions.
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Each event card has a window that contains the following information about an event:

¹ Date and time the event occurred

¹ Name of the device to which the event pertains

¹ Which process of the NetView for AIX program or network sent the event

¹ Summary description of the event

¹ A more detailed description of the event

¹ Description of the device as obtained from the device MIBs and the NetView for
AIX object database

¹ The severity assigned to the event

 ¹ Notes

Using the Event Card Buttons
Across the bottom of the event card are three buttons labeled Note, Browse MIB, and
Highlight. Let's explore what each of them does.

Step 1. Click mouse button 1 on the Note button.

The Note Editor dialog box appears.

Step 2. Type the following note in the text-entry field:

I'm adding this event to my error log.
(your name here)

Step 3. Click mouse button 1 on the File pull-down menu.

Step 4. Select Save and then Close from the File pull-down menu.

Can you see your note on the event card? You might need to scroll to the
bottom of the window.

Step 5. Click mouse button 1 on the Browse MIB button in the event card at the front
of the card stack.

The MIB Browser dialog box appears. You don't need to know everything
about the MIB Browser right now, but basically what you can do from the
event card is look at and get the current values of the MIB objects for which
the event was generated. You can also, if necessary, use the MIB Browser
to change the values of particular MIB objects.

Step 6. Click mouse button 1 on the Close button to close the MIB Browser dialog
box.

Step 7. Click mouse button 1 on the Highlight button. A new submap window is dis-
played.

Look at the submap window. You should see the object about which the
event was generated highlighted on the submap. The Highlight button shows
you exactly where the object is in the submap hierarchy. Once you find the
object, you can use other NetView for AIX operations to work with it. For
example, you could open a workspace with all events related to this object.
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Step 8. Click mouse button one on the system menu for the submap.

Step 9. Select Close from the system menu to close the submap.

What the Event List Format Tells You
The event list format contains the following information:

¹ Date and time the event occurred
¹ Name of the device
¹ Source of the event
¹ Description of the event

Figure 24 shows the format for the event list display.

Figure 24. The event list shows a subset of event card information.

 Try This

Double-click mouse button 1 on an event item in the list. A new Static Workspace
containing the card is created. Select File..Close from the Static Workspace menu
to close the new workspace.

 Try This

To highlight symbols that correspond to selected events, select an event, click
mouse button 3 on the event card to bring up the Work Menu, and select Highlight
nodes on map. Do you see a highlighted symbol?
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 Using Workspaces

 Key Concepts

Workspace A window that displays events.

Filter A set of conditions applied to events that come to NetView for AIX.
Filters determine which events are displayed in workspaces by the
Events Display application.

You can use workspaces to organize events in ways that are meaningful for the partic-
ular network monitoring task you are performing. For example, you can create work-
spaces to save events selected according to certain criteria, such as all events from
one network device, all events with a certain severity level, or all events received during
a particular period of time. Then, you can use the workspaces, along with any map
snapshots you have taken, for help with identifying network problems.

Using Dynamic and Static Workspaces
The NetView for AIX graphical interface displays two types of workspaces: dynamic and
static.

 Key Concepts

Dynamic Workspace Displays real-time events as they are received by NetView
for AIX. Filters and event correlation rules can be used to
display selected events.

Static Workspace Results from a select or create operation, or from an order
operation performed on the contents of a dynamic work-
space.

The title of each workspace tells you whether it's dynamic or static. Every dynamic
workspace has a Freeze button, Filter button, and FreezeRes button. The freeze
button allows you to stop the display of incoming events temporarily, if necessary.

The Filter button on the dynamic workspace allows the user to toggle filtering on/off
within the workspace. When a filter is activated within a workspace, the filter button will
be set on.

The FreezeRes button is used to toggle the resolution of event correlation capability
within a workspace. While the FreezeRes button is depressed, correlated events will
not be resolved (or cleared), and resolution is halted until the button is raised again.
When the FreezeRes button is raised again, incoming correlated events will be
resolved. However, those events that would have been resolved while the FreezeRes
button was depressed will not be cleared.
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The dynamic workspace is opened with all available events that match the update cri-
teria you specify. New events are added to the workspace if they match the update
criteria.

 Fields
The Dynamic Workspace dialog box contains three panes. The top pane contains two
fields:

Workspace Title Specify a name for this workspace.

Correlation Rule Specify a correlation rule to be used to select events for this
workspace. Select the Rules List  button to view a list of
correlation rules from which you can choose.

The second pane contains the following fields:

Category Selectable field. Select the event categories from which you
want to include events in the new dynamic workspace.
Events from all selected categories will be included.

Severity Selectable field. Select the event severity level from which
you want to include events in the new dynamic workspace.
Events with all selected severities will be included.

Source Read-write field. Enter the event source for which you want
to include events in the new dynamic workspace, or click on
the Select button to display a list of available event sources.
The event source is a one-character value. Events from all
selected sources will be included.

Enter string to filter Read-write field. Enter one or more text strings that you
wish to use to include or exclude events in the new dynamic
workspace. After entering a string, select the Include on
WS or Exclude from WS  button for the desired action. To
remove a string from either list, select the string and then
choose the Delete  button.

The third pane of the Dynamic Workspace dialog box contains one field, titled Active
Filters List . This field lists the filters that have been chosen for this workspace.

The third pane includes these buttons:

Filter Activation Accesses the Filter Control dialog box, enabling you to
select a filter from a selection list showing available filters.

Up and Down Arrows These arrows enable you to revisit parts of the workspace
dialog that you have already completed. They are activated
after you select the Next  button in the button panel.
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 Buttons
The Dynamic Workspace dialog box contains the following buttons in the button panel:

OK Accepts the selections and closes the dialog box.

The dynamic workspace is opened with all available events that match
the specified update criteria.

Next Enables you to create a new set of criteria, which will be ORed with the
other sets you specify for this workspace.

Cancel Cancels the operation and closes the dialog box.

Clear Clears all the fields in the dialog box.

Help Displays the help entry for this dialog box.

Creating Dynamic Workspaces
There are three ways to create a dynamic workspace:

¹ Starting the NetView for AIX graphical interface creates a dynamic workspace.
This workspace displays all events received during the current NetView for AIX
session unless they are being filtered to display specific events. This workspace
appears in the Control Desk window that is attached to the main submap window.

¹ Selecting Create..Dynamic Workspace from the main menu in the Events Display
application creates a dynamic workspace. This workspace can use filters to
display only selected events. It can also monitor the occurrence of specific
network situations. For example, you can display events from a specific category,
event source, or severity. Filters that are active for the Events Display Application
Main Workspace will also be active for dynamic workspaces created this way.
Think of the dynamic workspaces as additional filters. If filters are active for the
main workspace, events will be filtered twice.

¹ Selecting Monitor..Events..Current Events operation to create another dynamic
workspace to look at events pertaining to a selected device.

The default limit on the number of events a dynamic workspace can contain is 500. If
this default is exceeded, the oldest events must be discarded in order to accomodate
new ones.

Using Dynamic Workspaces
The Creation Dialog Box gives you the capability to mix several types of events attri-
butes in one workspace. This means you can select all "critical" and "major" severities
to display in one workspace or any other kind of attributes combination.

How is this done? Imagine that you have a list of events you want to receive in a sepa-
rate workspace. Suppose you want to see all of the critical severity events, but only
the Network Topology category ones. Another kind of event you want to see is the
Netmon source with cleared or major severities and Error Events or Status Events cate-
gories. In this example you select two types of events to display in the same work-
space. Each type must be entered in the dialog box the following way:
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1. Select the first event selection.

2. Click on the All Severities toggle button and then click on the Critical button
(Severity list) to select all critical events.

3. Click on the All Categories toggle button and then on the Network topology events
to select only the network topology events.

To select another set of selection criteria, press the "Next" button. The dialog box is
refreshed and the big up arrow located in the lower right hand corner of the dynamic
workspace panel is highlighted. This indicates that there is a previous event type
defined. To select the selection criteria:

1. Click on All Sources and Netmon buttons (Source list). This selects all Netmon
events.

2. Click on All Severities, Major and Cleared button to display major and cleared
severities.

3. Click on All Categories button and then select Error Events and Status Events.

4. Click on OK.

A new dynamic workspace is created to display the events you have selected. The big
arrows are used to display all the event types created to update the dynamic work-
space. You can see and change them.

For each dynamic workspace you can activate filters and correlation rules. You can
only do one correlation rule per workspace. Filters and rulesets may have already
been created for you. For information on event correlation filters and rulesets refer to
the, NetView for AIX Administrator's Guide.

The Dynamic Workspace dialog box is displayed as shown in Figure 25 on page 66.
The dialog box can be seen as three horiziontal sections comprised of a top, middle
and bottom.
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Figure 25. Using the dynamic workspace, you can filter events.

Creating Static Workspaces
Static workspaces contain a subset of the events in a dynamic workspace, up to a
default limit of 500 events. Static workspaces are generated from the result of oper-
ations you perform on the contents of a dynamic workspace. Their contents do not
change automatically. Figure 26 shows a static workspace containing event cards.

Figure 26. A static workspace contains a subset of dynamic workspace events.
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You can perform many of the same operations on the events in a static workspace that
you can perform on the events in a dynamic workspace. One thing you can't do,
though, is activate and deactivate filters. You can do that only from a dynamic work-
space. Because the Events Display Application Main Workspace is a dynamic work-
space, you can activate or deactivate filters.

Using Events in the Events Display Application
Let's create a static workspace so you can see how it's done. The easiest way is to
create a static workspace that contains all of the events in the Events Display Applica-
tion Main Workspace.

Step 1. Select Static Workspace from the Create pull-down menu in the Events
Display Application Main Workspace main menu.

Step 2. Select All from the cascade menu.

A Static Workspace opens in the Control Desk window. You can display this
workspace in a separate window by clicking mouse button 2 on its icon and
dragging the icon to another location on the desktop, then dropping it.

Saving a Workspace
Suppose you wanted to save this workspace so you could send it to someone, or look
at it later. Here's how to do it:

Step 1. Select Save As from the File pull-down menu in the workspace.

Step 2. Select All from the cascade menu.

The Event Information window is displayed.

Step 3. Click mouse button 1 on the OK button to save the workspace under the
default file name, as follows:

/u/<userid>/<userid>.events<x>.WS

Where <userid> is your user ID and <x> is the sequential number of the
workspace.

The Event Information dialog box displays a message:

OK! Save completed!

Now, let's load this saved workspace so we can look at it again.

Step 4. Select Load from the File pull-down menu in the workspace.

The File Selection dialog box is displayed. This dialog box displays lists of
directories that contain saved workspaces, and lists of the saved workspaces
in each directory.

Step 5. Click mouse button 1 on the name of the workspace you just saved; you
should see its name in the Files field.

The Selection field should now contain the full path name of this workspace.

Step 6. Click mouse button 1 on the OK button to close the File Selection dialog box
and display this workspace in the Control Desk window.
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Notice the bottom right corner of the workspace window. There, you see a
message that tells you which directory this workspace was loaded from, so
you know that this is a workspace that was previously saved, not one that
was just created.

Sorting Events in a Static Workspace
You can create a static workspace that places the contents of the Events Display Appli-
cation Main Workspace in a specified order, for example, by hostname or severity. By
default, events are ordered by the time of occurrence. Let's create a static workspace
that sorts events in a specific order:

Step 1. Select Static Workspace from the Create pull-down menu in the Events
Display Application Main Workspace.

Step 2. Choose Selected or All from the cascade menu. If you have not selected any
events previously, you must select All as Selected will not be operational.

Step 3. Select Hostname from the cascade menu.

A static workspace is displayed in the Events Display Application Main Work-
space, with the contents of the dynamic workspace placed in alphabetical
order by hostname.

Step 4. Click mouse button 2 on the icon that represents this workspace and drag the
icon to another area of the desk top. Release mouse button 2 to drop the
workspace.

Step 5. Create another static workspace from the contents of the Events Display
Application Main Workspace; this time use Severity as the sorting criterion.

Compare the top event cards in each workspace. They should be different,
because you've sorted by different criteria for each workspace.

There's one other way to create a static workspace. You'll learn about it in “Searching
for Events.”

Searching for Events
You can search for events in one of two ways:

 ¹ Search..By Criteria
 ¹ Search..By Filter

 By Criteria
Suppose you want to find only the events pertaining to one particular network device,
for example, the router you've worked with in Chapter 3, “Working with Maps” on
page 39. Let's try it now.

Step 1. Select By Criteria from the Search pull-down menu in the Events Display
Application Main Workspace.

The Search by Criteria dialog box is displayed.

Step 2. Type the name of the router in the Search String field.
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Look at the rest of the Search by Criteria dialog box. You can select a spe-
cific event source, category, or severity to search on instead of, or in addition
to, the search string. And, you can choose to have the search results dis-
played in a separate workspace or selected in the Events Display Application
Main Workspace. You can tell when event cards are selected because they
are a darker shade of tan than the other cards. For now, make sure the
Select Events radio button is selected.

Step 3. Click mouse button 1 on the OK button to close the Search by Criteria dialog
box.

Step 4. Select Show Status from the Options pull-down menu in the Events Display
Application Main Workspace. The Status Information window tells you how
many events the search operation selected.

Step 5. Click mouse button 1 on the OK button to close the Status Information
window.

Step 6. Select Static Workspace from the Create pull-down menu in the Events
Display Application Main Workspace.

Step 7. Select Selected from the cascade menu.

A static workspace containing only the selected events as a result of your
search is displayed in the Control Desk window. There, you've just seen the
third way to create a static workspace.

 By Filter
You can also search for events according to whether they match certain filtering criteria.
Let's try it:

Step 1. Select By Filter from the Search pull-down menu in the Events Display Appli-
cation Main Workspace.

The Search by Filter dialog box is displayed.

Step 2. Click mouse button 1 on the name of a filter in the Filter/Description field.

Step 3. Click mouse button 1 on the Activate button.

The filter is immediately activated and a workspace containing events that
passed through the filter you selected is created in the Control Desk window.

Getting Information about a Workspace
Select the Options..Show Status operation from the menu in the events application to
see the following information:

¹ Whether the workspace is dynamic or static

¹ The name of the workspace

¹ The number of events in the workspace

If the workspace is dynamic this figure is not updated as more events are received.
You must select this operation again to see the new total number of events in the
workspace.
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¹ The number of events in the workspace that are selected

¹ The number of workspaces currently open

¹ For dynamic workspaces, the status of their updating

¹ For dynamic workspaces, whether any filters are active

The Save Environment Feature
Your system might already be configured to save the event workspace configuration
and to start the events display application with the saved workspaces. You should
check with your system administrator to find out how your system is configured.
Whether your system is configured to save the environment or not, you can use the
Options..Save Environment menu bar option from the main workspace to override your
workspace configuration. For example, if your system is configured to save your work-
space, you will see a radio button next to the Options..Save Environment option. This
is a toggle button. When the radio button is depressed it is on and active; when it is
raised it is off and inactive.

When you exit the events display application, a dialog box will prompt you to save the
current environment. If you want to save the current envirionment, press the OK button
which will create files in the ($HOME/NvEnvironment) in the user's home directory. If
you do not wish to save your current environment, press the Cancel button. You will
not get the most recently configured environment next time you bring up the event
display application. If you choose to save your workspace environment, your system
must be configured to load the saved environment. As previously mentioned, check
first with your system administrator to determine how your system has been configured.

Looking at Events in the Event Log
The events received by the NetView for AIX program are saved in a log file. You can
use the Event History application to display events from this file. This application dis-
plays logged events for a selected network device.

Step 1. Create a filter. Ask your system administrator if a filter already exists that
you can use for this task. If there is, go to step 14. Otherwise, continue with
the next step.

Step 2. Click mouse button 1 on the router symbol in the submap window. Write
down the name of the router.

Step 3. Select Events from the Monitor pull-down menu.

Step 4. Select Event History from the Events cascade menu. The Event History
application opens in the Control Desk window. You can see the new title,
Events History Application Main Workspace, in the title bar.

Step 5. Select Filter Control from the Workspace Options pull-down menu.

Step 6. Click mouse button 1 on the Start Filter Editor button.

Step 7. Click mouse button 1 on the Add Simple button.
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Step 8. Enter a filter name and description. Use alphanumeric characters to name
your filter anything you want. Do not include spaces in the name. You might
want to name the filter “testfilter” or “practicefilter.”

Step 9. Click mouse button 1 on the From Objects Equal to List button.

Step 10. Click mouse button 1 on the Name or IP Address field and enter the name of
the router.

Step 11. Click mouse button 1 on the Add to List button. This button adds the node to
the List of Objects field.

Step 12. Click mouse button 1 on the OK button to close the Simple Filter dialog box.

Step 13. Click mouse button 1 on the Close button to close the Filter Editor dialog box.

Step 14. Select the filter you just added from the Available Filters in File list and click
mouse button 1 on the Activate button. The filter name is added to the
Active Filters List.

Step 15. Click mouse button 1 on the Close button.

Step 16. Select Display Event from the Query pull-down menu in the workspace.

The workspace fills with cards representing logged events pertaining to this
router.

Step 17. Select Exit from the File pull-down menu in the Events History Application
Main Workspace to close this workspace and the Events History application.

 Try This

You can also start the Events History application by dragging the Event History
icon from the Tools window into the Control Desk window. If you want the applica-
tion to run in a separate window, drag the icon from the Tools window and drop it
elsewhere on the desktop.
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Reviewing What You Learned
Take a few minutes to review what you learned in this chapter. You should know:

¹ What an event is
¹ What a trap is
¹ What the Events Display application does
¹ What the Events History application does
¹ Where events are stored
¹ How to display events in card or list formats
¹ What a workspace is
¹ What the difference is between a dynamic and a static workspace
¹ How to create dynamic and static workspaces
¹ How to search for events

Now, we're going to put all of this information to use, as we learn how to use the
NetView for AIX program to monitor a network in Chapter 5, “Monitoring a Network” on
page 73.
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Chapter 5. Monitoring a Network

Up until now, you've been learning about the individual parts of NetView for AIX. Now,
it's time to put everything together and learn how to use the NetView for AIX program to
monitor a network. This chapter presents scenarios to help you learn about:

¹ Checking connectivity within the same network
¹ Checking connectivity across networks
¹ Responding to a red symbol

 ¹ Reporting problems
¹ Collecting and reporting network data

When problems occur, the exact steps you take to resolve them will be determined by
your job responsibilities. These scenarios can give you some ideas about the kind of
information to gather and what steps to take when certain network conditions occur.

Your system administrator should have created a submap for you to use for performing
the tasks in this chapter. If not, you can probably find the symbols referred here on
your submaps.

 Connectivity Trouble
Suppose you get a call from someone who is trying to telnet from their machine to
another machine in the network. Sometimes, the connection works, but at other times
it takes a while to make the connection.

Here are some steps you can take in response to the problem:

¹ Check the connectivity.
¹ Locate the route.
¹ Determine who is the system contact responsible for the device.
¹ Graph Interface traffic.
¹ Send the problem, including the graph, to the system contact.

Check the Connectivity
Check the status of the IP-level connection between the two machines. The steps may
vary a little depending on where the machines are located. They might be in the same
network or in different networks. Let's practice both scenarios.

 Key Concept

A ping is used to test Internet Protocol-level connectivity to a destination by
sending an ICMP echo request and waiting for a response. When you ping a
system, you are sending packets of information. If no one is there to receive it,
you won't get a response. The system or connection is probably down. If it is
received, you'll get a response telling you the packet was sent, or transmitted, and
received.
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Within the Same Network
In this scenario, you are working from the Management Station. The caller is on
System A and trying to telnet to System B. These steps assume the two systems are
within the same network. Figure 27 shows the network.

System A System B

Management
Station

Figure 27. Checking Connectivity within the Same Network

Step 1. Locate on the submap the machines to which the caller is referring. You
might need to use the Locate..Objects..By Selection Name operation to find
them.

Step 2. Look at the symbols. Is either one of them red? If so, it is down. Report the
problem to your system administrator. If they are green or yellow, continue to
the next step.

Step 3. Click mouse button 1 to select the green or yellow symbol. Select
Monitor..MIB Values..Interface Info . Look under ifOperStatus to see if an
interface is down.

Make a Note

Write the name and address of the interface that is down.

________________________

If an interface is not down, click mouse button 1 on the Close button and
continue to the next step.

Step 4. Click mouse button 1 to select the symbol for System B.

Step 5. Select Ping from the Test pull-down menu to send a ping to System B. The
Ping window is displayed, containing the results of repeated pings sent to
System B.

Step 6. Click mouse button 1 on the Stop button to stop the ping.

Step 7. Look at the message in the Ping dialog box. Does it say that some per-
centage of packets have been lost? If so, that means there could be a
problem with the IP connection between System B and your machine. Make
a note of the message; you'll want to send this information to someone else
later.
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If the message tells you that no packets are being lost, the connection is fine.
Now, do the same thing for System A. If the ping for both machines is okay,
continue to the next step.

Step 8. Press and hold the Ctrl key and click mouse button 1 to select the symbols
for Systems A and B.

Step 9. Select Remote Ping from the Test pull-down menu. This sends a ping
between the two machines. If the ping fails, continue to the next step. If the
ping is successful, you might have a hostname-to-IP address mapping
problem. Report the problem to your system administrator.

Step 10. Press and hold the Ctrl key and click on System A to deselect it, and then
click on the Management Station symbol to select it. System B should
already be selected.

Step 11. Select Network Configuration..ARP Cache from the Monitor pull-down menu.

Step 12. Look at the ARP Cache tables and find System A's link address in both
tables. Because the ping failed in step 9, they should be different. Make a
note of both addresses and send a note to your system administrator to
request changing System A's link address on System B.

 Across Networks
In this scenario, the caller is trying to connect from System B on Network 1 to System
C on Network 2. The path between the two networks includes two gateways: Gateway
1 and Gateway 2. You are working on the management station. Figure 28 shows the
network.

Network 1 Network 2

G1 G2

System A System B System C System D

Network 3

Management
Station

G3

Figure 28. Checking Connectivity Across Networks

  Chapter 5. Monitoring a Network 75



Step 1. Locate System C on the submap and check the status color. If it is red,
System C is down. Report the problem to your system administrator. If it is
not red, continue to the next step.

Step 2. Click mouse button 1 to select System C.

Step 3. Select Ping from the Test pull-down menu.

Step 4. Click mouse button 1 on the Stop button. If no packets are lost, the con-
nection is okay. Continue to the next step. If the ping fails, do the following:

a. Locate G2 on the submap.

b. Click mouse button 1 to select the symbol for G2.

c. Select Ping from the Test pull-down menu to send a ping to G2.

d. Click mouse button 1 on the Stop button.

e. If the ping is successful, the connection is okay. Continue to the next
step. If the ping fails, G2 is down. Report the problem.

Step 5. Locate System B and select it.

Step 6. Select Ping from the Test pull-down menu.

Step 7. Click mouse button 1 on the Stop button. If the ping is successful, continue
to the next step. If the ping fails, do the following:

a. Locate G1 and select it.

b. Select Ping from the Test pull-down menu.

c. Click mouse button 1 on the Stop button. If the ping is successful, con-
tinue to the next step. If the ping fails, G1 is down. Report the problem.

Step 8. Check the route between the two nodes to determine whether any interme-
diate nodes are experiencing problems.

a. Press and hold the Ctrl key.

b. Click mouse button 1 to select the symbols for Systems A and B.

c. Select Locate Route: via SNMP from the Test pull-down menu.

The Locate Route dialog box is displayed, showing you the intermediate
connections between the machines.

Make a Note

Write the name, or IP address, of the routers that connect the two machines here:

__________________________

d. Click mouse button 1 on the Close button to close the Locate Route
dialog box.
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 Key Concept

A hop is the next node, usually a gateway, that data needs to travel through to get
from point A to point B. It can be any node that routes data. For example, using
Figure 28 on page 75, sending something from system A to system C takes two
hops: G1 and G2.

Step 9. Look at the submap. You'll see that the path for the selected nodes is high-
lighted. Verify that the path is correct. For example, in Figure 28 on
page 75, if the route led to G3 rather than G1 or G2, System B's routing
table is incorrect.

You should be able to follow the route on a single submap, but if the route is
not completely visible from a single submap, you can open other submaps
along the path.

Step 10. Look at the submap to see whether all nodes along the correct path are oper-
ating. A node with a yellow or red status indicates that the node either has a
problem or is not operating. If a node is yellow or red, report the problem to
your system administrator. You can capture a picture of the screen to send
with the note. See “Send Problem Information for Further Analysis” on
page 78 for those steps.

If the route is correct and everything is up along the path, the problem might
not be related to connectivity, but rather to performance or network service.
Report the problem.

Determine The System Contact
Now that you've collected several kinds of information about the caller's problem, you
can send it to someone for analysis, for example, the person who is responsible for one
of the routers. Here's how to find the name of that person:

Step 1. Click mouse button 1 to select the router symbol

that you wrote down earlier.

Step 2. Select Modify/Describe..Object from the Edit pull-down menu. The Object
Description dialog box is displayed.

Step 3. Select IP Map and then click mouse button 1 on the View/Modify Object Attri-
bute button.

The Attributes for Object dialog box is displayed. Look for the System
Contact field. That's the person to notify about problems with the router. If
that field is empty, notify your system administrator.

Step 4. Click mouse button 1 on the Cancel button to close the Attribute for Object
dialog box.
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Step 5. Click mouse button 1 on the Cancel button to close the Object Description
dialog box.

Graph SNMP Traffic Statistics
Before You Begin

You must have read-write access to the /tmp/xnmgraph.data directory. If you're not
sure, ask your system administrator.

Sometimes a machine's behavior is affected because the router to which it's attached is
having problems. Now that you know the name of a router, or routers, that connect
Systems B and C, you can graph the real-time volume of SNMP traffic a router is han-
dling. Once you've captured several minutes' worth of activity, you can save the graph
and send it to your system administrator, who can take further steps to analyze the
problem.

Step 1. Click mouse button 1 to select the router symbol. Do you remember how to
locate an object? Use the Locate pull-down menu.

Step 2. Using mouse button 2, drag the icon for the SNMP Traffic application from
the Tools window to the control desk window and drop it.

A graph labeled Monitor: SNMP Traffic is displayed in the Control Desk
window.

Step 3. Collect statistics for two minutes.

Step 4. Select Save As from the File pull-down menu in the graph application.

Step 5. Type a file name in the File Name field in the Save Monitor: SNMP Traffic
window.

Step 6. Click mouse button 1 on the Apply button to save the collected data to the
file name you specified.

Send Problem Information for Further Analysis
You've gathered enough information about the problem to pass along to your system
administrator, who can figure out what's wrong. The following steps show you how to
send the graph and add a note explaining what you've found:

Step 1. Click and hold down mouse button 2 on the Mail Tool icon in the Tools
window. When the icon is displayed, drag the icon to the Control Desk
window and release the mouse button.

The mail tool is displayed in the Control Desk.

Step 2. Select New from the Compose pull-down menu of the Mail Tool.

Step 3. Click mouse button 1 on the title bar (the bar with the words Mail Tool -
Compose) to move the dialog box to the upper corner of the screen.

Place the Monitor: Interface Traffic control desk in the foreground without
overlapping any other screens (click on the Interface Traffic icon in the appli-
cation stack). You must do this to ensure that you capture the entire image.
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You might have to minimize other windows on the desktop to be sure you
avoid overlap.

Step 4. Type the system contact name in the Destination field of the Mail Tool -
Compose dialog box.

Step 5. Type:

SNMP Traffic Graph

in the Subject field of the Mail Tool - Compose dialog box.

Step 6. Type:

Router101 experiencing 37% packet loss.
See attached SNMP traffic graph.

in the Text field of the Mail Tool - Compose dialog box. Replace the above
information with information about your router.

Step 7. Select Capture from the Capture pull-down menu on the Mail Tool - Compose
dialog box.

The cursor changes to a pointer.

Step 8. Move the cursor to the graph and click mouse button 1 to capture the image
of the graph.

Wait until the image is displayed in the Image field.

Step 9. Select Send from the Deliver pull-down menu on the Mail Tool - Compose
dialog box to send the message and image.

 Try This

Practice sending a captured image to yourself, then selecting View to look at your
mail.

When a Symbol Turns Red
Suppose you're looking at a network submap and a symbol representing a router on the
network changes to red. What might be wrong? More to the point, what do you do?
Here are a few suggested steps:

Step 1. Search for events related to the problem.
Step 2. Check the device's interfaces.
Step 3. Send a note to inform your system administrator.

Search for Events Related to the Problem
When a symbol is red, it means that something in the network has gone down. In this
example, one, or all, of the router's interfaces are having problems. Let's try to find out
why:

Step 1. Find a router symbol that is red.
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Step 2. Write down the name of the router. See “Getting a Description of an Object”
on page 44 if you don't remember how to get the name of the router.

Step 3. Search in the event display window for events associated with the router.

a. Select by Criteria from the Search pull-down menu in the Events Display
Application Main Workspace.

b. Type the name of the router in the Search String field.

Step 4. Put them in a workspace.

a. Click on the Create Workspace radio button.

b. Click on the OK button. A static workspace containing all the events for
the router opens.

Use the scroll bar located on the right to look through the event cards.
Looks like an interface is down. Can you find the event card telling you
an interface is down?

Step 5. Use the Highlight button on the card to find and highlight the router on a
submap. A submap is displayed showing the router highlighted.

Step 6. Check the device's interfaces. Double-click on the router symbol to check it's
interfaces. One interface is red.

Step 7. Use the mail tool to send a note informing the system administrator about the
interface.

Collecting and Reporting Network Data
NetView for AIX provides data collection and thresholding capabilities to help you
retrieve information about selected network objects between the regularly scheduled
polling intervals. Your system administrator can tell you what information you need to
collect for your network. If you collect data before a problem occurs, you can send the
information to your system administrator who can then resolve the problem.

Collecting Network Data
Let's practice collecting some snmpInPkts data.

Step 1. Click mouse button 1 to select an object for which you want to change data
collection.

Step 2. Click mouse button 1 to select Data Collection & Thresholds: SNMP from the
Tools pull-down menu.

Step 3. Click mouse button 1 to select the snmpInPkts MIB object ID in the MIB
Objects Configured for Collection field on the MIB Data Collection dialog box.

Step 4. Click mouse button 1 on the Resume button.

Step 5. Click mouse button 1 to select the collection interval value in the MIB Object
Collection Summary field on the MIB Data Collection dialog box.

Step 6. Type 1m in the Polling Interval field of the Collection Details section of the
MIB Data Collection dialog box to change the collection interval to 1 minute.
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Step 7. Type 15 in the Threshold field of the Collection Details section of the MIB
Data Collection dialog box to change the threshold value to 15.

Specifying a threshold of 15 sets a limit of 15 traps per minute.

Step 8. Type 80 in the Rearm field of the Collection Details section of the MIB Data
Collection dialog box to change the rearm value to 80.

When the number of threshold events falls below or is equal to the rearm
value (80% of 15, or 12), a rearm event is generated. Another threshold
event is not generated until the rearm event occurs and the number of events
once again exceeds the threshold value.

Step 9. Click mouse button 1 on the Replace button to replace old values with the
new values you have entered.

Step 10. Click mouse button 1 on the Apply button to begin data collection.

Note:  Allow time for data to be collected (about 5 minutes).

Step 11. Click mouse button 1 on the Show Data button on the MIB Data Collection
dialog box.

Step 12. Click mouse button 1 on the Graph button on the MIB Data Collection / Show
Data dialog box to display a graph of the collected data.

The NetView for AIX Grapher displays a graph of the collected data.

Reporting Network Data
Now that you have changed threshold and rearm values, and collected and graphed
data, you can run a report to format the graphed information. Use the database of your
choice to create reports. NetView for AIX Database Guide contains information about
using your database. Your system administrator can help you with this task.

 Congratulations!
You've completed the tasks in this book. We hope this book has helped you learn the
basics of NetView for AIX. Now you're ready to put everything you learned to work.
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 Glossary

This glossary includes terms and definitions from:

¹ The American National Standard Dictionary for Infor-
mation Systems, ANSI X3.172-1990, copyright 1990
by the American National Standards Institute
(ANSI). Copies may be purchased from the Amer-
ican National Standards Institute, 11 West 42nd
Street, New York, New York 10036. Definitions are
identified by the symbol (A) after the definition.

¹ The ANSI/EIA Standard—440-A, Fiber Optic Termi-
nology. Copies may be purchased from the Elec-
tronic Industries Association, 2001 Pennsylvania
Avenue, N.W., Washington, DC 20006. Definitions
are identified by the symbol (E) after the definition.

¹ The Information Technology Vocabulary, developed
by Subcommittee 1, Joint Technical Committee 1, of
the International Organization for Standardization
and the International Electrotechnical Commission
(ISO/IEC JTC1/SC1). Definitions of published parts
of this vocabulary are identified by the symbol (I)
after the definition; definitions taken from draft inter-
national standards, committee drafts, and working
papers being developed by ISO/IEC JTC1/SC1 are
identified by the symbol (T) after the definition, indi-
cating that final agreement has not yet been
reached among the participating National Bodies of
SC1.

¹ The Network Working Group Request for Com-
ments: 1208.

¹ The IBM Dictionary of Computing, New York:
McGraw-Hill, 1994.

¹ The Object-Oriented Interface Design: IBM Common
User Access Guidelines, Carmel, Indiana: Que,
1992.

The following cross-references are used in this glossary:

Contrast with:  This refers to a term that has an
opposed or substantively different meaning.

Synonym for:  This indicates that the term has the same
meaning as a preferred term, which is defined in its
proper place in the glossary.

Synonymous with:  This is a backward reference from a
defined term to all other terms that have the same
meaning.

See: This refers the reader to multiple-word terms that
have the same last word.

See also:  This refers the reader to terms that have a
related, but not synonymous, meaning.

Deprecated term for:  This indicates that the term
should not be used. It refers to a preferred term, which
is defined in its proper place in the glossary.

A
action .  (1) In the AIX Operating System, a defined task
that an application performs. An action modifies the
properties of an object or manipulates the object in some
way. (2) An operation on a managed object, the
semantics of which are defined as part of the managed
object class definition.

active .  (1) The state a resource is in when it has been
activated and is operational. Contrast with inoperative.
(2) In the AIX Operating System, pertaining to the
window pane in which the text cursor is currently posi-
tioned.

address .  See internet address.

agent .  In the TCP/IP environment, a process running
on a network node that responds to requests and sends
information.

AIX.  Advanced Interactive Executive.

AIX Operating System .  (1) IBM's implementation of
the UNIX Operating System. The AIX Operating System
runs on the RISC System/6000 system. (2) See UNIX
Operating System.

AIX NetView Service Point .  (1) A licensed program
that operates in the AIX and UNIX environments. The
AIX NetView Service Point functions as a gateway in an
unattended environment. (2) A workstation-based IBM
licensed program through which application programs
can be used to monitor, manage, and diagnose prob-
lems in non-SNA networks and communication devices.

API.  Application programming interface.

application programming interface .  (1) A library of
routines, provided with a product, which allows customer
or vendor programmers to integrate applications with the
product. (2) A routine within such a library.
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apply button .  A push button in a dialog box that is
used to invoke an operation on the existing contents of
that dialog box. Using the apply button does not cancel
the dialog box.

ARP cache .  Address resolution protocol cache.

attribute .  (1) Objects are defined by attributes. Object
attributes appear as fields in the Object Description
dialog box and Attributes dialog boxes for applications.
The NetView for AIX windows tool provides a dialog box
that displays general attributes and capabilities of
objects based on their attributes. (2) See also managed
object and managed object class.

B
background process .  (1) In the AIX Operating
System, a mode of program execution in which the shell
does not wait for program completion before prompting
the user for another command. (2) A process that does
not require operator intervention but can be run by the
computer while the workstation is used to do other work.
(3) Contrast with foreground process. (4) See also
daemon.

behavior .  (1) A characteristic of a symbol that deter-
mines what happens when the symbol is selected with
the mouse. Symbol behavior may be either explodable
or executable.

Explodable Double-clicking on the symbol causes
a question dialog box to be displayed:

The question dialog box provides
three choices: use the default submap,
modify the submap settings, or cancel
this submap creation.

Executable The symbol executes an application
that performs an action on a set of
target objects.

(2) See also executable symbol and explodable symbol.

browse .  To look at records in a file.

button .  A word or picture on the screen that can be
selected. Once selected and activated, a button begins
an action in the same manner that pressing a key on the
keyboard can begin an action. (R)

C
cache .  (1) A special-purpose buffer storage, smaller
and faster than main storage, used to hold a copy of
instructions and data obtained from main storage and
likely to be needed next by the processor. (T) (2) A
buffer storage that contains frequently accessed
instructions and data; it is used to reduce access time.
(3) An optional part of the directory database in network
nodes where frequently used directory information may
be stored to speed directory searches. (4) To place,
hide, or store in a cache.

cancel button .  (1) Exits the dialog box and resets the
values of its contents. (2) See button.

card .  (1) A unique place to display information that
relates to an event. A card provides a repository for
information and a fast path to the MIB browser applica-
tion and the topology map representation of managed
objects. Cards are placed in workspaces and can be
sent to other users, searched, ordered, and reports can
be generated from them. (2) See also MIB and work-
space.

child submap .  (1) A submap that represents a
detailed view of an object, or the “contents” of an object
(called the parent object) on a map. Double-clicking on
an explodable symbol that represents the parent object
opens the child submap. (2) See also parent object.

click .  To press and release a mouse button.

client .  (1) In an AIX distributed file system environ-
ment, a system that is dependent on a server to provide
it with programs or access to programs. (2) See also
server.

close button .  (1) A push button that closes and exits a
dialog box. (2) See button.

CMIP.  Common Management Information Protocol.

CMIS.  Common Management Information Services.

CMOT.  Common Management Information Protocol
over TCP/IP.

command .  (1) A request from a terminal for the per-
formance of an operation or the execution of a particular
program. (2) A request to perform an operation or run a
program. When parameters, values, flags, or other
operands are associated with a command, the resulting
character string is a single command. (R)
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Common Management Information Protocol (CMIP) .
The protocol elements used to provide the operational
and notification services defined by Common Manage-
ment Information Services. CMIP is part of the Organ-
ization for Standardization (ISO) and Open Systems
Interconnection (OSI) specification.

Common Management Information Services (CMIS) .
A suite of operational and notification services used for
the management of systems. CMIS is a part of the
International Organization for Standardization (ISO) and
Open Systems Interconnection (OSI) specification.

Common Management Information Protocols over
TCP/IP (CMOT).  A protocol interface defined by the
Internet Engineering Task Force (IETF) that enables the
use of CMIP over a TCP/IP protocol stack.

compound status .  (1) The compound status scheme
determines how status is propagated from symbols in
child submaps to symbols of the parent object. The
combined status of symbols determines the resulting
compound status. Compound status can propagate up
through multiple levels of submaps in the network map.
The compound status setting applies to the entire map.
In effect, the status of specific nodes propagates up to a
symbol on a higher-level submap. Compound status is
configured by using one of three schemes:

 ¹ Default
¹ Propagate Most Critical
¹ Propagate at Threshold Value

(2) See default compound status.

configuration .  (1) The manner in which the hardware
and software of an information processing system are
organized and interconnected. (T) (2) The devices and
programs that make up a system, subsystem, or
network. (3) The act of organizing and interconnecting
the components of an information processing system.

connection .  (1) In system communications, a line over
which data can be passed between two systems or
between a system and a device. (2) A physical or
logical link between objects that appears as a line
between them on the topology map. For example, the
connection line between a gateway and network repres-
ents an interface on that network. Multiple connections
appear as one line. (3) Synonym for physical con-
nection.

context menu .  (1) A menu (also known as a pop-up
menu) that provides no visual cue to its presence, but
pops-up when operators perform a menu selection with
button 3 of a three-button mouse.

control desk .  (1) A component of the graphical inter-
face that enables the network operator to group applica-
tions instances together. The operator can create
multiple control desks through configuration of the
X-Defaults file or by using the mouse to drag the control-
desk icon from the Tool Palette. (2) See also tool
palette.

critical status .  (1) In the NetView for AIX program, the
status state, displayed by a symbol, that indicates a
problem with the object. If the status is compound
status, it reflects a critical condition in the parent object's
child submap. If the status is direct status, it may reflect
a critical condition for the symbol or the object. The
default color for critical status is red. (2) See normal
status, marginal status, and compound status.

D
daemon .  (1) A background process usually started at
system initialization that runs continuously and performs
a function required by other processes. (2) In the AIX
Operating System, a program that runs unattended to
perform a standard service. Some daemons are trig-
gered automatically to perform their task; others operate
periodically. (3) See also background process.

data .  A representation of facts, concepts, or
instructions in a form suitable for communication, inter-
pretation, or processing by human or automatic means.
Data includes constants, variables, arrays, and character
strings.

default .  An initial configuration setting. Defaults are
supplied when the NetView for AIX program is first run
to reduce the amount of time required to start actively
managing systems on a network. Users and applica-
tions can alter many default settings.

default compound status .  When a new map is
created, compound status is set to a default value. The
default value for compound status causes the graphical
interface to propagate status.

demand poll .  An operation of the NetView for AIX
program that checks for network nodes that are new.
The demand poll operation performs the following tasks:

¹ Provides information about a new network node,
such as the node's interfaces and internet address.

¹ Updates the node's status on open submaps.

¹ Checks for exceeded thresholds and logs events.
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destination .  Any point or location, such as a node,
station, or a particular terminal, to which information is to
be sent.

device .  A mechanical, electrical, or electronic
contrivance with a specific purpose.

dialog box .  (1) A dialog box provides data fields and
buttons for setting controls, selecting from lists, choosing
from mutually exclusive options, entering data, and pre-
senting the user with messages. The NetView for AIX
dialog boxes are defined by OSF/Motif. (2) A pop-up
window that is used primarily to gather user input.

display .  (1) A visual presentation of data. (I) (A)
(2) To present data visually. (I) (A) (3) A device or
medium on which information is presented, such as a
terminal screen. (4) Deprecated term for panel.

DOC. Documentation.

domain .  (1) That part of a network in which the data
processing resources are under common control. (T)
(2) In a database, all the possible values of an attribute
or a data element. (3) In TCP/IP, the naming system
used in hierarchical networks. The domain naming
system uses the DOMAIN protocol and the named
daemon. (4) In a domain system, groups of hosts are
administered separately within a tree-structured hier-
archy of domains and subdomains.

domain name .  (1) A naming scheme consisting of a
sequence of subnames separated by a period. Each
section of the domain name is called a label. (2) In
TCP/IP, a name of a host system in a network. A
domain name consists of a sequence of subnames sep-
arated by a delimiter character.

double-click .  To press and release a mouse button
twice in rapid succession.

drag .  To press and hold a mouse button while moving
the mouse to move the pointer on the computer display.
Symbols can be dragged from the Add Object Palette or
Add Connection Palette to a submap to place a symbol
on a submap. Dragging is used to select menus, move,
and resize submap windows or dialog boxes.

dynamic .  (1) In programming languages, pertaining to
properties that can be established only during the exe-
cution of a program; for example, the length of a
variable-length data object is dynamic. (I) (2) Pertaining
to an operation that occurs at the time it is needed
rather than at a predetermined or fixed time. (3) In
NetView for AIX, the contents of windows in the event

display function are either dynamic or static. In the
dynamic display (workspace), events continue to be
added to the cards/list. (4) Contrast with static.

E
echo .  In data communication, a reflected signal on a
communications channel. On a communications ter-
minal, each signal is displayed twice, once when entered
at the local terminal and again when returned over the
communications link. This allows the signals to be
checked for accuracy.

end-user interface (EUI) .  See graphical user interface
and EUI.

Enhanced X-Windows Toolkit .  (1) In the AIX Oper-
ating System, a collection of basic functions for devel-
oping a variety of application environments. Toolkit
functions manage Toolkit initialization, widgets, memory,
events, geometry, input focus, selections, resources,
translation of events, graphics contexts, pixmaps, and
errors. (2) See also X-Window System.

enterprise .  An entire business organization. An enter-
prise may consist of one or more establishments, divi-
sions, plants, warehouses, and so on that require an
information system.

enterprise-specific MIB .  (1) An SNMP management
Information Base (MIB) developed by individual vendors
for specific products. Vendors register their private MIBs
under the enterprise object identifier subtree. (2) See
MIB.

entity .  (1) In the NetView for AIX program, an element
on a network that has semantic attributes. (2) See also
object.

error .  A discrepancy between a computed, observed,
or measured value or condition and the true, specified,
or theoretically correct value or condition. (I) (A)

error log .  (1) A data set or file in the AIX Operating
System where error information is stored. Applications
write to the AIX error log in response to hardware and
software errors. (2) A form in a maintenance library that
is used to record error information about a product or
system. (3) A record of machine checks, device errors,
and volume statistical data.

EUI. (1) End-user interface. (2) Synonymous with
graphical interface.
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event .  (1) An occurrence of significance to a task, such
as an SNMP trap or an NetView for AIX internal event.
(2) In the NetView for AIX program, an unsolicited notifi-
cation from the managed object or SNMP agent that at
least one of the following has occurred:

¹ A threshold limit was exceeded.
¹ The network topology changed.
¹ An informational message or an error occurred.
¹ An object's status changed.
¹ A node's configuration changed.

(3) In the NetView and NETCENTER programs, a
record indicating irregularities of operation in physical
elements of a network. (4) A CMIP event report.

event card .  In the NetView for AIX program, a graph-
ical representation, resembling a punched card, of the
information contained in an event sent by an agent to a
manager reflecting a change in the status of one of the
agent's managed nodes.

EXEC.  (1) In the AIX Operating System, to overlay the
current process with another executable program.
(2) See also fork.

executable symbol .  (1) A symbol configured such that
double-clicking on it causes an application to perform an
action on a set of target objects. When you change the
behavior of a symbol to executable, you choose from a
list of registered applications and actions, and you
choose a set of objects (target objects) that the applica-
tion acts upon. You can modify these settings at any
time. Executable symbols are useful for easily per-
forming complex network management tasks as often as
needed. (2) See explodable symbol and behavior.

explodable symbol .  (1) A symbol configured such that
double-clicking on it displays the child submap of the
parent object that the symbol represents. The child
submap displays the contents of the parent object. If the
object the symbol represents has no child submap, a
question dialog box appears enabling you to create and
configure a child submap. After the submap is created,
double-clicking on the symbol opens the child submap.
(2) See executable symbol and behavior.

F
feature .  A part of an IBM product that may be ordered
separately by the customer. A feature is designated as
either special or specify and may be designated also as
diskette-only.

field .  Fields are the building blocks of which objects are
composed. A field is characterized by a field name, a
data type (integer, Boolean, character string, or enumer-
ated value), and a set of flags that describes how the
field is treated by NetView for AIX. A field can contain
data only when it is associated with an object.

filter .  (1) In the NetView for AIX program, a set of cri-
teria that determines which events are received by regis-
tered applications, selected for displaying, or forwarded
to the NetView and NETCENTER programs as alerts.
(2) In the NetView program, a function that limits the
data that is to be recorded on the database and dis-
played at the terminal. See recording filter and viewing
filter. (3) In the AIX Operating System, a command that
reads standard input data, modifies the data, and sends
it to the display screen. (4) A device or program that
separates data, signals, or material in accordance with
specified criteria. (A)

filtering .  In the NetView for AIX program, a process
that applies tests to previously identified objects to
extract a subset.

foreground process .  (1) In the AIX Operating System,
a process that must run to completion before another
command is issued to the shell. The foreground process
is in the foreground process group, which is the group
that receives the signals generated by a terminal. (2) In
the NetView for AIX program, the xnm application and
the applications running under it. (3) Contrast with
background process.

fork .  (1) In the AIX Operating System, to create and
start a child process. (2) See also EXEC.

function index .  (1) An index that enables you to get
online help that describes the functions of the graphical
interface. You can display the Function index from the
Help menu. (2) See also help menu.

G
gateway .  (1) In the AIX Operating System, an entity
that operates above the link layer and translates, when
required, the interface and protocol used by one network
into those used by another distinct network. (2) A func-
tional unit that interconnects two computer networks with
different network architectures. A gateway connects net-
works or systems of different architectures. A bridge
interconnects networks or systems with the same or
similar architectures. (T) (3) In TCP/IP, a device used
to connect two systems that use either the same or dif-
ferent communication protocols.
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graph .  In multiple topology, a graph represents a col-
lection of vertices, arcs, and other graphs. An IP
segment is a graph that contains all IP machines and
their connections.

graphical user interface .  (1) In the NetView for AIX
program, the integrating interface application that pro-
vides the means for displaying submaps and for inte-
grating network applications. The graphical interface is
a single, consistent interface that enables multiple appli-
cations to interact. (2) See also EUI.

grayed .  A menu selection or button that is not currently
enabled for the given context and appears dim in com-
parison to other selections.

H
help button .  Displays the help entries.

help menu .  An action bar menu to provides detailed
help information about the NetView for AIX graphical
interface. It also provides information about registered
applications that are integrated with the graphical inter-
face.

help panel .  Information displayed by a system in
response to a help request from a user. See task panel.

heterogeneous network .  A network with multiple man-
agement protocols.

highlighting .  (1) In the NetView for AIX program, a
visual cue showing the nodes or connections that are
the output of certain operations. (2) Emphasizing a
display element or segment by modifying its visual attri-
butes. (I) (A)

home submap .  A starting point on a map. The home
submap is the first submap that appears when a map is
opened. Each map may have a home submap. When
new maps are created, the home submap is the root
submap.

host .  (1) The primary or controlling computer in the
communications network. (R) (2) A computer attached
to a network. (R) (3) In TCP/IP, any system that has at
least one Internet address associated with it. A host
with multiple network interfaces may have multiple
Internet addresses associated with it. (4) See also host
processor.

host processor .  (1) A processor that controls all or
part of a user application network. (T) (2) In a network,
the processing unit in which the access method for the
network resides.

I
ICMP.  Internet Control Message Protocol.

icon .  A graphic symbol, displayed on a screen, that a
user can point to with a device, such as a mouse, in
order to select a particular function or software applica-
tion. (T)

ID. Identification.

inoperative .  The condition of a resource that has been
active, but is not. The resource may have failed,
received an INOP request, or been suspended while a
reactivate command is being processed.

interface .  A shared boundary between two functional
units, defined by functional characteristics, signal charac-
teristics, or other characteristics, as appropriate. The
concept includes the specification of the connection of
two devices having different functions. (T)

internet .  A series of connected networks that use
Internet protocol.

Internet .  A wide-area network connecting thousands of
disparate networks in industry, education, government,
and research. The Internet network uses TCP/IP as the
standard protocol for transmitting information.

internet address .  The numbering system used in
TCP/IP Internetwork communications to specify a partic-
ular network, or a particular host on that network, with
which to communicate. Internet addresses are denoted
in dotted decimal form.

Internet Control Message Protocol (ICMP) .  A pro-
tocol used by a gateway to communicate with a source
host, for example, to report an error in a datagram.
ICMP is an integral part of the Internet Protocol.

internet-level submap .  The highest level of the
topology map that shows how internet protocol networks
or subnets are connected by gateways.

IP.  Internet Protocol.

ISO.  International Organization for Standardization
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L
label .  A label is used to distinguish a symbol from other
symbols on a submap and map. The label is displayed
below a symbol. Labels can be assigned or modified at
any time by using the Symbol Description dialog box.

legend .  An explanatory list of the symbols, icons, and
other components of a network.

link .  (1) In data communications, a transmission
medium and data link control component that together
transmit data between adjacent nodes. (R) (2) In
TCP/IP, a communications line. A TCP/IP link may
share the use of a communications line with SNA.

local .  Pertaining to a device, file, or system that is
accessed directly from your system, without the use of a
communications line. Contrast with remote. (R)

M
managed object .  (1) An object that is being actively
managed. Applications can monitor and manage objects
for topology, status, and configuration changes. When
you choose to manage an object, the objects in child
submaps of the managed object also become managed.
An object can be toggled between managed and unman-
aged. You can choose which objects to manage,
thereby, customizing the management region for any
map. (2) See unmanaged object and management
region.

managed object class .  A named set of managed
objects sharing the same (named) sets of attributes,
notifications, management operations (packages), and
which share the same conditions for presence of those
packages. (I)

management information base (MIB) .  (1) A set of
variable bindings that reflect the current state of an
SNMP agent. Extensions to the MIB can be added by a
business enterprise. (2) See also enterprise-specific
MIB.

management region .  The set of managed objects on a
particular map that defines the extent of the network that
is being actively managed. The management region
may vary across maps.

manager .  The part of a distributed management appli-
cation that issues requests and receives notifications;
that is, uses the services of one or more agents.

map .  A set of related submaps that provides a graph-
ical and hierarchical presentation of a network and its
systems.

menu .  A list of options displayed to the user by a data
processing system, from which the user can select an
action to be initiated. (T)

menu bar .  A rectangular area at the top of the client
area of a window that contains the titles of the standard
pull-down menus for that application. (R)

menu item .  One of a list of options contained in a
menu.

message .  (1) An assembly of characters and some-
times control codes that is transferred as an entity from
an originator to one or more recipients. A message con-
sists of two parts: envelope and context. (2) Information
from the system that informs the user of a condition that
may affect further processing of a current program. (R)

MIB.  Management Information Base.

monitor .  (1) A device that observes and records
selected activities within a data processing system for
analysis. Possible uses are to indicate significant
departure from the norm, or to determine levels of utili-
zation of particular functional units. (T) (2) Software or
hardware that observes, supervises, controls, or verifies
operations of a system. (A)

motif .  See OSF/Motif.

mouse .  A device that a user moves on a flat surface to
position a pointer on a panel. It allows a user to select a
choice or function to be performed or to perform oper-
ations on a panel, such as dragging or drawing lines
from one position to another.

N
navigation tree .  A component of the graphical user
interface that forms a hierarchy of open submaps illus-
trating the parent-child relationship. The navigation tree
enables the network operator to determine which
submaps are currently open and to close, restore, or
raise the windows that contain submaps.

NetView program .  An IBM licensed program used to
monitor a network, manage it, and diagnose network
problems.
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network .  (1) An arrangement of nodes and intercon-
necting branches. (T) (2) A configuration of data proc-
essing devices and software connected for information
interchange.

network address .  (1) An identifier for a node, station,
or unit of equipment in a network. (2) An address, con-
sisting of subarea and element fields, that identifies a
link, a link station, or a network addressable unit.
Subarea nodes use network addresses; peripheral
nodes use local addresses. The boundary function in
the subarea node to which a peripheral node is attached
transforms local addresses to network addresses and
vice versa. (3) See also network name.

network manager .  A program or group of programs
that is used to monitor, manage, and diagnose the prob-
lems of a network.

network name .  (1) The symbolic identifier by which
end users refer to a network addressable unit, a link, or
a link station within a given network. In APPN networks,
network names are also used for routing purposes.
(2) See also network address.

network operator .  (1) A person who controls the oper-
ation of all or part of a network. (2) In a multiple-domain
network, a person or program responsible for controlling
all domains.

node .  (1) An end point of a link, or a junction common
to two or more links in a network. Nodes can be
processors, controllers, or workstations, and they can
vary in routing and other functional capabilities. (R)
(2) The portion of a hardware component, along with its
associated software components, that implements the
functions of the seven architectural layers (SNA). (3) In
a tree structure, a point at which subordinate items of
data originate. (R)

node-level submap .  Contains the addressable
resources of a network, such as a gateway, router, work-
station, and personal computer.

normal status .  (1) Indicates that a network object is
functioning normally. The default icon symbol color for
normal status is green. The default connection symbol
color for normal status is black. (2) See critical status
and marginal status.

notification .  Information emitted by a managed object
relating to an event that has occurred within the
managed object. (I)

O
object .  (1) In the NetView for AIX program, a generic
term for any entity that NetView for AIX discovers and
displays on the topology map, or any entity that you add
to the topology map. (2) In the AIX object data
manager, an instance or member of an object class,
conceptually similar to a structure that is a member or
array of structures. (3) In the NetView for AIX program,
objects convey to the symbol various semantic attributes
that represent an entity. (4) See managed object.
(5) See also entity and symbol.

object attribute .  (1) An object is defined by its attri-
butes. The attributes are fields in which values are
stored. For any object, an Object Description dialog box
enables you to highlight applications and display attri-
bute values that specific applications use to manage the
object. For example, each object has a selection name
attribute. The value of any selection name is the textual
name of the object. Objects that support SNMP have an
IP address attribute. The attribute value of any object
supporting SNMP is the actual address. Applications
and users may assign new values to object attributes,
and may provide new attributes for certain objects.
(2) See managed attribute. (3) See also attribute,
object, and selection name.

object class .  (1) In NetView for AIX, objects are
divided into four classes: computer, connector, device,
software, location, and cards. (2) In the AIX object data
manager, a stored collection of objects with the same
definition. Conceptually similar to an array of structures.
(3) See also object class, symbol class, and managed
object class.

object ID .  The unique name identification of a manage-
ment information base object.

OK button .  Saves and cancels the value of the dialog
box.

online .  (1) Pertaining to the operation of a functional
unit when it is under the direct control of the computer.
(T) (2) Pertaining to a user's ability to interact with a
computer.

online information .  Information stored in a computer
that can be displayed, used, and modified in an interac-
tive manner without any need to obtain hard copy.

open button .  Opens a submap for each selected entry.
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open systems interconnection (OSI) .  The intercon-
nection of open systems in accordance with standards of
the International Organization for Standardization (ISO)
for the exchange of information. (T) (A)

Operating System/2 (OS/2) .  A set of programs that
control the operation of high-speed large-memory IBM
personal computers (such as the IBM Personal System/2
computer, Models 50 and above), providing multitasking
and the ability to address up to 16MB of memory.

operator .  (1) A person who operates a device. (2) A
person or program responsible for managing activities
controlled by a given piece of software such as MVS,
the NetView program, or IMS. (3) A person who keeps
a system running. (4) See network operator.

OS/2.  Operating System/2

OSF.  Open Software Foundation.

OSF/Motif .  (1) A graphical interface that contains a
tool kit, presentation description language, window
manager, and style guideline. (2) See also Open Soft-
ware Foundation.

OSI.  Open systems interconnection.

P
page .  The information displayed at the same time on
the screen of a display device.

panel .  (1) A formatted display of information that
appears on a terminal screen. (2) In computer graphics,
a display image that defines the locations and character-
istics of display fields on a display surface. (3) See help
panel. Contrast with screen.

parent object .  The relationship that an object has with
its child submap. Symbols of a parent object can
appear on multiple submaps.

paste .  (1) Used in conjunction with the Cut and Copy
menu item to complete a cut-and-paste operation or a
copy operation. It retrieves items from the cut buffer and
places symbols of objects on a submap of your choice.
(2) See also copy and cut buffer.

physical connection .  (1) A connection that estab-
lishes an electrical circuit. (2) In the NetView for AIX
program, a point-to-point connection or multipoint con-
nection. Synonymous with connection.

ping .  Packet internet groper. Used to test Internet
Protocol-level connectivity to a destination by sending an
ICMP echo request and waiting for a response.

polling .  (1) On a multipoint connection or a point-to-
point connection, the process whereby data stations are
invited, one at a time, to transmit. (I) (2) Interrogation of
devices for such purposes as to avoid contention, to
determine operational status, or to determine readiness
to send or receive data. (A)

pop-up menu .  In the AIXwindows program, a type of
MenuPane widget that appears as the result of some
user action, usually clicking a mouse button, and then
disappears when the action is completed.

protocol .  (1) A set of semantic and syntactic rules that
determine the behavior of functional units in achieving
communication. (I) (2) In Open Systems Interconnection
architecture, a set of semantic and syntactic rules that
determine the behavior of entities in the same layer in
performing communication functions. (T)

pull-down menu .  In the AIXwindows program, a type
of MenuPane widget that gives the appearance of being
pulled down from a MenuBar widget as the result of a
user action, usually, clicking a mouse button.

push button .  A rectangle that appears as three-
dimensional with text inside. Push buttons are used in
windows for actions that occur immediately when the
push button is selected.

R
read-only access .  (1) In the NetView for AIX program,
an open map that a user can view. A map open with
read-only access displays status, allows submap and
snapshot traversal, and enables you to monitor and
locate objects. The File..Refresh Map menu item is
used to update the topology of a map open with read-
only access. Objects, symbols, submaps, and snap-
shots cannot be deleted or modified. (2) See read-write
access.

read-write access .  (1) In the NetView for AIX
program, an open map that a user can change. This
map is continuously updated with status and topology
changes. With read-write access, objects, symbols,
submaps, and snapshots can be added or deleted within
the map. Only one user can have a map open with
read-write access at a given time. (2) See read-only
access.
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real time .  (1) In Open Systems Interconnection archi-
tecture, pertaining to the processing of data by a com-
puter in connection with another process outside the
computer according to time requirements imposed by the
outside process. This term is also used to describe
systems operating in conversational mode and proc-
esses that can be influenced by human intervention
while they are in progress. (I) (A) (2) In Open Systems
Interconnection architecture, pertaining to an application
such as a process control system or a computer-
assisted instruction system in which response to input is
fast enough to affect subsequent input.

recording filter .  In the NetView program, the function
that determines which events, statistics, and alerts are
stored on a database.

remote .  (1) Pertaining to a system, program, or device
that is accessed through a telecommunication line.
(2) A device that does not use the same protocol and is,
therefore, unknown. (3) Contrast with local.

remote ping .  (1) A packet internet groper that is used
to test the connectivity between two remote network
devices. (2) See also ping.

resource .  Any facility of the computing system or oper-
ating system required by a job or task, and including
main storage, input/output devices, the processing unit,
data sets, and control or processing programs.

response .  (1) In data communications, a reply repres-
ented in the control field of a response frame. It advises
the primary or combined station of the action taken by
the secondary or other combined station to one or more
commands. (2) See also command.

ring .  A network configuration in which devices are con-
nected by unidirectional transmission links to form a
closed path.

RISC.  Reduced instruction-set computer.

root-level submap .  Contains the highest level of the
submap hierarchy. Multiple networks can be placed
within the root level submap.

route .  An ordered sequence of nodes and transmission
groups (TGs) that represents a path from an origin node
to a destination node traversed by the traffic exchanged
between them.

router .  See Internet router.

routing .  (1) The process of determining the path to be
used for transmission of a message over a network. (T)

(2) The assignment of the path (route) by which a
message will reach a destination on the network. (3) In
X.25 communications, the process by which a packet
gets to the intended user. (R)

S
screen .  (1) In the AIX extended curses library, a
window that is as large as the display screen of the
workstation. (2) Deprecated term for display panel.

scroll .  To move a display image vertically or horizon-
tally to view data that cannot be observed within a single
display screen.

scroll bar .  In the AIX Operating System, a graphical
device used to change a user's viewpoint of a list or
data file. A scroll bar consists of a slider, scroll area,
and scroll arrows. A user changes the view by sliding
the slider up or down in the scroll area or by pressing
one of the scroll arrows. This causes the view to scroll
up or down in the window adjacent to the scroll bar.

segment .  (1) A group of display elements. (2) A con-
tiguous area of virtual storage allocated to a job or
system task. A program segment can be run by itself,
even if the whole program is not in main storage. (3) A
portion of a computer program that may be executed
without the entire program being resident in main
storage. (4) In AIX Enhanced X Windows, one or more
lines that are drawn but not necessarily connected at the
end points. (5) In the IBM Token-Ring Network, a
section of cable between components or devices on the
network. A segment may consist of a single patch
cable, multiple patch cables connected together, or a
combination of building cable and patch cables con-
nected together.

segment-level submap .  Represents the topology of a
segment of a network. A segment submap contains
network nodes and connectors.

select .  (1) In the AIX Operating System, to choose a
button on the display screen. (2) To place the cursor on
an object (name or command) and press a button on the
mouse or the appropriate key on the keyboard.

selection list .  A list of selected objects for the open
map or open snapshot. The selection list provides a list
of objects on which various operations can be invoked
by users and applications. As objects are selected or
deselected, the selection list is immediately updated.
The selection list will display the objects' selection
names. When a map and snapshot are open concur-
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rently, each will have an independent list of selected
objects.

selection name .  (1) The unique name of an object that
is used in a selection list. The NetView for AIX program
identifies an object by its selection name. An object can
be assigned a selection name through the Add Object
dialog box. (2) See also object and object attribute.

server .  (1) In the AIX Operating System, an application
program that usually runs in the background and is con-
trolled by the system program controller. (2) In
Enhanced X Windows, provides the basic windowing
mechanism. It handles IPC connections from clients,
demultiplexes graphics requests onto screens, and multi-
plexes input back to clients. (3) See also client.

shell script .  A synonym for shell procedure.

Simple Network Management Protocol (SNMP) .  A
protocol running above the User Datagram Protocol
(UDP) used to exchange network management informa-
tion.

SNA.  Systems Network Architecture.

SNMP.  Simple Network Management Protocol.

static .  (1) In programming languages, pertaining to
properties that can be established before execution of a
program; for example, the length of a fixed length vari-
able is static. (T) (2) In NetView for AIX, static work-
space contains only certain events. The static
workspace is not updated. (3) Pertaining to an opera-
tion that occurs at a predetermined or fixed time.
(4) Contrast with dynamic.

station .  An input or output point of a system that uses
telecommunications facilities; for example, one or more
systems, computers, terminals, devices, and associated
programs at a particular location that can send or
receive data over a telecommunication line.

status .  (1) The current condition or state of a program
or device. (R) (2) In the NetView for AIX program, the
condition of a node or portion of a network as repres-
ented by the color of a symbol on a submap.

status propagation .  (1) The changing of the status of
compound objects based on the propagation rules of the
objects contained entirely within it. (2) See also propa-
gate most critical and propagate threshold.

submap .  (1) A particular view of some aspect of a
network that displays symbols that represent objects.

Some symbols may explode into other submaps, usually
having a more detailed view than their parent submap.
The application that creates a submap determines what
part of the network the submap displays. (2) See also
root-level submap, internet-level submap, node-level
submap, and segment-level submap.

submap menu .  Contains menu items that are used to
change how symbols are displayed on specific submaps
or all submaps of the open map.

submap stack .  A component of the graphical interface
shown on the left side of each submap window. The
submap stack represents the ancestry of all submaps.
Selecting a submap representation from the stack
causes the contents of the current submap window to be
replaced with the selected submap. Dragging a submap
representation from the stack causes a new window to
be opened.

submap window .  A submap window contains an
NetView for AIX menu bar, a submap viewing area, a
status line, and a button box. You can display multiple
submap windows of an open map and an open snapshot
at any given time.

symbol .  (1) In the NetView for AIX program, a picture
or icon that represents an object. Each symbol has an
outside and inside component.

¹ The outside component differentiates the object
classes.

¹ The inside component differentiates the objects
within the class.

(2) See also object class and symbol class.

symbol class .  (1) A collection of symbols that have
the same or similar properties. A symbol class is
represented by the shape of the symbol. Each symbol
subclass in a given class contains the same shape.
Each symbol class has a unique set of subclasses asso-
ciated with it. Applications may register additional
symbol classes. Some of the registered symbol classes
provided with the NetView for AIX program include:

 ¹ Computer
 ¹ Connector
 ¹ Device
 ¹ Software
 ¹ Location
 ¹ Cards

You can view all the registered classes from the Display
Legend panel, or from the Add Object Palette. (2) See
also symbol subclass and symbol type.
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symbol label .  A name assigned to a symbol to distin-
guish it from other symbols in a submap. A symbol label
may be displayed below the symbol. Symbol labels are
optional.

symbol subclass .  (1) A set of symbols that is in a
given symbol class. A particular subclass in a given
class defines the type of the symbol. For example, in
the symbol class called Computer, the subclasses
consist of PC, workstation, mini, and mainframe. All
symbols in the subclass of the same class contain the
same outline (shape). The NetView for AIX program dis-
plays the symbol subclass as the graphic inside the
outer shape of the symbol. (2) See also symbol class
and symbol type.

symbol type .  (1) The symbol type consists of the
symbol class and the symbol subclass. A specific
symbol type is defined by the concatenation of a symbol
class and a symbol subclass within that class. The
symbol class is identified on submaps by the outer
shape of the symbol and the symbol subclass by the
graphic inside the shape. (2) See also symbol class
and symbol subclass.

T
task .  In a multiprogramming or multiprocessing environ-
ment, one or more sequences of instructions treated by
a control program as an element of work to be accom-
plished by a computer. (I) (A)

task index .  (1) An index that provides online help
entries for a variety of tasks that are available in the
NetView for AIX program and applications that are inte-
grated with the NetView for AIX program. The Task
Index can be accessed from the Help menu. (2) See
also help menu.

TCP.  Transmission Control Protocol.

TCP/IP.  Transmission Control Protocol/Internet Pro-
tocol.

telnet .  An application protocol offering virtual terminal
service in the Internet suite of protocols. With the telnet
service, a remote system can be connected to a local
system.

terminal .  (1) A device, usually equipped with a key-
board and a display device, capable of sending and
receiving information over a communications line.
(2) See also workstation. (R)

threshold .  In the NetView for AIX program, a setting
that specifies the maximum value a statistic can reach
before notification that the limit was exceeded. For
example, when a monitored MIB value has exceeded the
threshold, SNMPCollect generates a threshold event.

token .  (1) In a local area network, the symbol of
authority passed successively from one data station to
another to indicate the station temporarily in control of
the transmission medium. Each data station has an
opportunity to acquire and use the token to control the
medium. A token is a particular message or bit pattern
that signifies permission to transmit. (T) (2) A sequence
of bits passed from one device to another along the
token ring. When the token has data appended to it, it
becomes a frame.

tool palette .  (1) A component of the graphical interface
that enables the operator to open application instances
by using the mouse to drag-and-drop the icons that rep-
resent the application. (2) See also control desk.

Transmission Control Protocol/Internet Protocol
(TCP/IP).  A set of communication protocols that sup-
ports peer-to-peer connectivity functions for both local
and wide-area networks.

trap .  An unsolicited event generated by an agent and
forwarded to a manager. Traps inform the manager of
changes that occur in the network.

U
UNIX Operating System .  An operating system devel-
oped by Bell Laboratories that features multiprogram-
ming in a multiuser environment. The UNIX Operating
System was originally developed for use on minicom-
puters but has been adapted for mainframes and micro-
computers.

Note:  The AIX Operating System is IBM's implementa-
tion of the UNIX operating system. See AIX.

unknown status .  (1) The status of an object that is not
yet known or does not actually exist in the network. The
default icon symbol color for unknown status is Blue.
The default connection symbol color is Black. (2) See
critical status, normal status, unknown status, unman-
aged status, and status.

unmanaged object .  (1) An object that is not actively
managed. An unmanaged object displays status as
Unmanaged. It does not display active status (normal,
marginal, critical). Unmanaged objects do not display
compound status nor do they contribute to compound
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status. Objects can be kept in an unmanaged state if
they are not of interest. An object may be toggled
between a managed and unmanaged state. (2) See
managed object and unmanaged status.

unmanaged status .  (1) The status that indicates that
an object is unmanaged. The default icon symbol color
displayed to indicate unmanaged status is Wheat. The
default connection symbol color displayed is Black.
(2) See critical status, normal status, compound status,
unknown status, and status.

user .  Any person or anything that may issue com-
mands and messages to or receive commands and mes-
sages from the information processing system. (T)

V
value .  (1) A specific occurrence of an attribute, for
example, “blue” for the attribute color. (TC97) (2) A
quantity assigned to a constant, a variable, a parameter,
or a symbol.

variable .  (1) A name used to represent a data item
whose value can change while the program is running.
(2) In programming languages, a language object that
may take different values, one at a time. The values of
a variable are usually restricted to a certain data type.

(3) A quantity that can assume any of a given set of
values. (A)

view .  See submap.

viewing filter .  In the NetView program, the function
that allows a user to select the alert data to be displayed
on a terminal. All other stored data is blocked.

W
window .  A portion of a visual display surface in which
display images pertaining to a particular application can
be presented. Different applications can be displayed
simultaneously in different windows. (A)

workspace .  (1) That portion of main storage that is
used by a computer program to store the objects a user
creates. (2) Acts as a card holder for an event display
application. Most event-display-application functions are
applied on workspaces as report generation, search,
order, and append.

workstation .  (1) A functional unit at which a user
works. A workstation often has some processing capa-
bility. (T) (2) One or more programmable or nonpro-
grammable devices that allow a user to do work. (3) A
terminal or microcomputer, usually one that is connected
to a mainframe or to a network, at which a user can
perform applications.
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 Index

A
active window 9
agent 33
application

event display 58
mail tool 19

attach control desk to submap window 16
attributes of objects 44

B
bars, scroll 20
buttons

cascade 22
check 25
grayed, in dialog boxes 26
in dialog boxes 25
option 25
push 25
radio 25
tools 12
tree 12

C
capability fields 44
cards, event 58
cascade button 22
check button 25
checking

connectivity
across networks 75
within the same network 74

device interface 80
closing windows 14
CMIP protocol 36
CMIS 37
CMOT 36
collecting network data 80
colors, status 42
commands

get 37
nv6000 1
set 37

communication protocols 36

connectivity, testing 73, 74
control desk window

attaching submap window 16
description 8
detaching submap window 15

D
data

collecting 80
reporting 81

detaching control desk windows 15
devices, checking interface 80
dialog boxes

button graying 26
buttons 25
fields 24
lists 24

displaying
events 58
submaps 49

dragging and dropping 16

E
enterprise-specific MIB 33
environment, security variables 2
events

cards
buttons 60
displaying 58
information 60

causes for 58
displaying 57, 58
list

format 58
information 61

log, viewing 70
overview 57
scrolling lists 21
searching 68, 79

executable symbols 43
exiting the graphical interface 30
explodable symbols 43
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F
fields, capability 44

G
get command 37
graphical interface

initializing 6
presenting 6
starting 1
stopping 30
windows 8

graphing SNMP traffic statistics 78
grayed

buttons 26
menu selections 23

H
help 27

AIX Base OS InfoExplorer 29
for dialog boxes 29
indexes 27
legend 27
NetView for AIX help 27
NetView for AIX library 28
on help 27
on version 29

horizontal scroll bars 20

I
icons 11

dragging and dropping 16
moving 16

initializing NetView for AIX 6
interaction between objects and symbols 44
interfaces, checking 80

L
left-handed mouse 8
lists in dialog boxes 24
locating

a route 77
a submap 49
objects in the submap hierarchy 50

lowering windows 13

M
mail tool 19, 78
management information base (MIB) 33
manager 33
managing networks 31
managing windows 7
maps 45
maximizing windows 11
menus

cascade 22
grayed 23
pop-up 23
pull-down 22
system 13

MIB (management information base)
definition 33
enterprise-specific 33
objects 33
standard 33

MIB object IDs 34
minimized icons 12
minimizing windows 11
monitoring a network 73
mouse, using 7
moving

icons 16
windows 11

N
names, MIB objects 34
navigation tree window 8
network

data
collecting 80
reporting 81

getting a description 48
managing 31
monitoring 73

nv6000 command 1

O
objects

attributes 44
capability fields 44
characteristics 40, 44
getting a description 44
overview 40
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objects (continued)
symbol interaction 44

online help 27
opening a submap 49
operations, selecting 22
option button 25
order of graphical interface presentation 6
OSI protocol 36

P
pop-up menu 23
presentation, graphical interface 6
problems

reporting 78
searching, related events 79
sending information 78

propagating symbol status 52
protocols, network communication 36

CMIP 36
CMIS 37
CMOT 36
OSI 36
SNMP 36
TCP/IP 36

pull-down menu 22
push button 25

R
radio button 25
read-only map, opening x
reporting problems 78
restoring windows 12
route, locating 77

S
scroll bars 20
searching for events

by criteria 68
by filter 69

security
logging into netview

environment variables 1
password 1
profile 1
shift in / shift out 1

sending problem information 78

set command 37
sizing windows 11
snapshots

opening 54
overview 53

SNMP protocol 36
SNMP traffic statistics, graphing 78
standard MIB 33
starting NetView for AIX 1
status colors 42
steps for

attaching control desk windows 16
changing event display formats 58
checking connectivity, across networks 75
checking connectivity, same network 74
collecting network data 80
creating dynamic workspaces 64
creating static workspaces 67
creating static workspaces, existing events 68
detaching control desk windows 15
displaying event logs 70
dragging and dropping icons 16
exploring submap hierarchy 47
getting a network description 48
getting object descriptions 44
graphing SNMP traffic statistics 78
locating and displaying submaps 49
locating objects submap hierarchy 50
locating the system contact 77
opening snapshots 54
reporting network data 81
saving a static workspace 67
searching events by criteria 68
searching events by filter 69
searching events related to a problem 79
sending problem information 78
testing connectivity 73
using buttons on event cards 60
using pop-up menus 23
using pull-down and cascade menus 22
using scroll bars 21
working with dialog boxes 24

stopping the graphical interface 30
submap window 8
submaps

hierarchy 47
home 45
locating and displaying 49
overview 45
root 45
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submaps (continued)
scaling 46
sorting by Name or Layout 49
zooming 46

symbols
colors 42
connection 41
executable 43
exploding 43
icon 41
interaction with objects 44
overview 41
status 42, 52

synchronization message 6
system contact, locating 77
system menu 13

T
TCP/IP protocol 36
testing connectivity 73
tools

button 12
mail, using 19, 78
window 8, 17

tree
button 12
navigation 8
structure 34

V
vertical scroll bars 20
viewing

information 20
logs 70

W
windows

active 9
closing 14
control desk 8
lowering 11, 13
managing

with drag and drop 9
with mouse 7
with system menu 13

maximizing 11
minimizing 11

windows (continued)
moving 11
navigation tree 8
restoring 12
sizing 11
submap 8
tools 8

workspace
dynamic 64
getting information about 69
static 66
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